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Preface

Preface

Spatial Analysis and Decision Assistance is nearing its 15" year of development (2009) and
distribution. During that time the code has been applied by a wide array of users to a wide array
of applications. In order to assist users with their work, we have offered help in several ways.
There has been classroom instruction, online help, a user’s group, a constantly evolving help
file, and personal contact with users. This user guide represents an explanation and ongoing
discussion of SADA that has been tested and refined over time in all of these venues. Of
course, we have always offered a user’s guide for each version we’ve released. Previous user
guides were essentially the contents of the topic-oriented help file arranged into chapters. As a
result, they had little or no additional content.

This time, | decided to write the user guide from an application perspective rather than an
enumeration of every feature SADA has to offer. From my own experience with help
documentation, | have found it difficult to search through lists of topics to create an analysis that
suits my needs. It requires that you know exactly what you’re doing and exactly what the
feature names mean. This is usually not the case. Such topic-oriented listings are important and
the help file will always be a source for that type of learning.

In this text, applications drive the discussion, and features are introduced when they become
relevant. If you are a veteran user and interested in a specific feature or model, then the help file
will likely be the best choice for you. If you are interested in learning SADA through application
and hands on guidance, then this user guide is probably best.

While we have many users across many different fields, environmental pollution assessment
and remediation continues to be our focus. The text is therefore written within the language of
environmental characterization and remediation. Many of the methods have more far-reaching
application, and users from other walks of life can still benefit from this text.

There is a lot of emphasis on getting started with SADA. Such things as getting comfortable with
the interface, importing your data, and just succeeding at some very basic things. Many users
learn SADA on the job where there is never enough time. We wrote the chapters to begin as
simple as possible and increase in complexity as the chapters progress. If you need to jump to a
later chapter quickly and have never learned SADA, you should still focus as much as possible
on the early chapters.

The writing style is very “folksy” in nature, using a lot of “you” and “we” throughout the
discussion. The idea was to create a comfortable learning environment similar to our classroom
setting (the technical editors really hate us). Hopefully this will help. Comments are always
welcome at sada@tiem.utk.edu.

Robert Stewart

Project Lead
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Chapter 1: Introduction

Chapter 1: Introduction
Background

Spatial Analysis and Decision Assistance (SADA) began as a grass roots effort in 1996 between
the University of Tennessee and the Oak Ridge National Laboratory’s Environmental
Restoration program. The restoration program at ORNL was associated with the cleanup of
legacy waste across the Oak Ridge Reservation from activities related to WWII and the Cold
War arms race. The purpose of the effort was to develop tools that would integrate human
health and ecological risk assessment with geospatial processes in a manner that could directly
impact environmental restoration decisions. This would require the software to be generalized,
easy to use, and incorporate the risk models necessary for ongoing cleanup operations.

In the late 1990s and early 2000s, the US EPA continued to support SADA as it grew in
popularity. Shortly thereafter, SADA received support from the US Nuclear Regulatory
Commission. Through each of these major sponsors, SADA has grown significantly with
deployment of newer versions, national conferences, training at numerous facilities, classroom
education, collaboration with experts and other institutions, and a continually growing body of
documents, applications, and most importantly users. As of the development of this document,
SADA has over 15,000 users in the US and abroad.

Through its many development stages, the authors have attempted to maintain the original
principles of the project: everyday applicability and ease of use. This has resulted in the type of
interface and body of documentation available to users today. Because of its generalized
interface, the types of applications have extended beyond environmental remediation efforts into
areas of civil engineering, geology, ecology, and many other unexpected fields. For this reason,
SADA is also an excellent platform for developing new methods or utilizing existing methods in
new ways, particularly within a spatial context.

The current version of SADA represents a collaborative effort between authors, sponsors, and
users. To participate in this effort, please visit the SADA website
(http://www.tiem.utk.edu/~sada/index.shtml) at the University of Tennessee, where you can
learn how to join the SADA User’s Group or directly communicate with developers via
sada@tiem.utk.edu.

Here, we provide a broad laundry list of SADA’s capabilities. Each of these capabilities can be
used independently or in an integrated manner.

e Data Exploration and Visualization

e Geographic Information System

e Statistical Analysis

e Human Health Risk Assessment

e Ecological Risk Assessment

o Data Screening and Decision Criteria
o Geospatial Interpolation

e Uncertainty Analysis

e Decision Analysis

o Sample Designs
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¢ MARSSIM module

While SADA was written within the context of environmental analysis, many of the processes
were broadly constructed to deal with a wide array of problems concerning spatially distributed
information. For simplicity, this manual will be written in the language of environmental
assessment and will focus on example applications.

We will assume you are familiar with the Windows environment and comfortable with the topics
covered in this manual. References are made to other resources outside of the manual for
topics that may not be familiar to everyone. While some concepts may be discussed briefly, the
manual is written primarily to show how to implement these concepts within the software.

A number of files have been included on the distribution disks to help you get started. They
include comma-delimited data files (.csv), example SADA files (.sda), and some GIS layer files
(.dxf). The data sets contained in these files are intended for demonstration purposes only; they
were not originally sampled at the locations seen in the GIS overlays and have been altered.
ToxicologicalDatabases.mdb and ScenarioDatabases.mdb are also included for setting up the
human health risk module in SADA, while a benchmark database is included for ecological risk
assessment setup and a custom database is included for the custom analysis setup. These file
types will be discussed and demonstrated throughout the manual.

The general philosophy for how to use SADA can be described like this. You will create a
SADA file. Most Windows applications operate on files. For example, Excel has Excel Files
(-xIs), Word has Word files (.doc) and SADA has SADA Files (.sda). Everything you need will be
stored in your SADA file. When a SADA file is first created, it will not contain anything. Just like
when you create a new Excel workbook or Word document, there will be nothing but a blank
slate.

With your blank SADA file, you can begin to define the location of your site, maybe bring in
some GIS layers, and maybe import some data. SADA has easy ways to bring all this
information into the file. You will be able to see all these things in a simple graphics viewer. After
you have your information in SADA, you can begin to perform some statistics or visualization.
You can even run geospatial models like kriging, use the human health and ecological risk
models, and begin to see how all these things can be used to support different kinds of
decisions. When you’ve run your analysis, SADA keeps track of what you did so you can create
instant documentation and maintain complete transparency in your work. There are also a
number of ways that SADA can export your results to Excel, Word, or GIS systems such as
ArcMap.

Before we get too far ahead, you need to install SADA.
Installing SADA

Before installing SADA, check for the following minimal requirements:

e CPU: Pentium IV

o Disk Space: 400 MB

¢ RAM: 500 MB

e OS: 2000, XP, VISTA
e Clock: 1GHz

The following requirements, however, are recommended to enhance performance of geospatial
analyses:
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o CPU: Pentium IV or higher
o Disk Space: 1GB

o RAM: 1GB or higher

e OS: 2000, XP, VISTA

e Clock: 2 GHz

Very important: you must be logged in as an administrator on your computer when installing
SADA. If you are not the administrator, then SADA will not properly install or run. If you have no
login prompt on your computer, the chances are good that you are in fact the administrator.
However, if you are not certain, ask your IT folks.

Open up your web browser and visit the SADA website
(http://www.tiem.utk.edu/~sada/download.shtml) to download the latest copy of SADA. You will
be asked to fill out a simple questionnaire. This questionnaire does not check information, so if
you feel uncomfortable providing any information, you can just enter nonsensical information
into the window and it will accept it. This information is used only to help us understand the
location and interests of our users. This helps us continue to receive sponsorship and to provide
SADA as a free product.

Save the downloaded file to your desktop.
Run the installation setup.

You might be asked to install the .NET framework. This is required by SADA and is a normal
part of the installation process.

Follow the remaining installation instructions.

You can install SADA on as many machines as you like. Be aware though that SADA will not
install correctly when installed over a network or when run over a network. For example, you
cannot install SADA on a single network machine and allow users to run it remotely. It was
never designed with this in mind and serious errors are likely to occur.

SADA Layout

Before doing anything in SADA, let’'s take a moment to understand the main components that
make up the software: list boxes, interviews, windows, buttons, and menus. When SADA is first
opened, a welcome screen will appear. To do this, we need to first open SADA and then open a
SADA file. Start SADA by clicking on your Start button, then program files, then SADA 5.0 and
then finally SADA. When SADA opens, close the little welcome screen, and from the main
menu choose File >Open.

Behind the welcome screen are three empty windows. Only the Open button and the File and
Help menus will be enabled.
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After a SADA file is created, the menus and buttons will be enabled and the windows and list
boxes will display the corresponding data. In a moment, we will create a SADA file, but for now,
just keep reading. In the following image, the file ThreeDimensional.sda, which is distributed
with SADA, has been opened (any file name with a .sda extension is a SADA file).
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The design for SADA’s interface attempts to accomplish the following:

Steps Winklow

e Be as intuitive as possible.

¢ Maintain the same look and feel regardless of the modeling or assessment under
consideration.

e In a seeming contrast to the second objective, make the interface conform itself to the
interests and needs of the user at any given time. In particular, hide all but the most
relevant functions and options for any given modeling effort.

e Provide the user with some interface guidance on how to accomplish things but not force
them into a strict interview type format.

Let’s take a look at the interface and see how these were accomplished.

Navigate to the SADA installation directory and open the file TwoDimensional.sda. Any file
ending with the suffix (.sda) is a SADA file and contains virtually everything you'll need to
perform your analysis. SADA will respond by opening the SADA file and showing you the
following (your graphics on the right side might look different, but that’'s okay).
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At first glance, there seem to be a lot of things to consider in the interface; however, the
interface will remain in this same format regardless of the types of analyses and modeling that
you may do. Let’s begin by dividing the interface into its major parts.
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SECTION A
This section is the starting point for how the interface is controlled. It is comprised of:

Interview Box

Interpolate my data ﬂ

This box contains all the major things you can "do" with SADA written in "plain English". These
are referred to as interviews largely because each of them will produce a set of steps or
questions that you can go through (see next section). The number and type of interviews that
appear in this box depends on what particular analysis you might be interested in or what type
of data you are currently examining. For example, the interview "Contour Risk" only appears as
an option when you are doing a risk analysis. Another example is the interview that includes
map smoothing, which only appears when you are examining a spatial model. In this way,
SADA "hides" unnecessary functions or invalid functions in the interface, and the interface
dynamically adapts itself to your interests.

Analysis Box

General - |

This box displays the type of analysis (e.g., General, Human Health, Ecological, or Custom). For
a new file, only General is available. General is the default choice and simply means that the
data will be used in a straightforward way without applying any other framework or models, such
as risk. Later, you'll learn how to set up human health risk, ecological risk, MARSSIM, and even
your own custom analysis. After selecting an analysis, the interviews will change to display the
appropriate actions for that analysis, and the windows will change to reflect the data.

Data Type Box

Soil |

This box has been known by previous SADA users as the media box. It had this name originally
because SADA could only deal with one type of data, sampled point values, where media was
often specified. Media refers to soil, surface water, sediment, or groundwater. SADA, however,
can now deal with a number of data types and so the box name had to be generalized. For
example, elevation data can now be imported. Therefore, this box is now called Data Type
instead of media. SADA organizes and presents your data by its data type.

Data Set Box

AC-225 |

This box contains each data set found under the selected Data Type (see above). Historically,
this was called the analyte box because SADA was explained only in the language of
environmental contaminant measurements (even though it was applied in many different kinds
of applications). Now, even within an environmental context, we’ll have to let go of the term
analyte box since SADA includes imported models, user-defined models, and elevation maps.
In this example, we can see we have a data set of Ac-225 data, and we know it's a soil type
data set because that is our selection in the data type box shown above.

Label Box
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For the measured sample or point type data sets, users may import additional metadata with
their core required values. This label box allows you to see these metadata plotted alongside
your point values in the map. If any other data type is selected, it will be disabled.

Layer Box

Z=0 |

SADA is actually a 3d tool in which you can do 2d analyses. So, all spatial information has a
vertical component (even if it is 2d) that must be addressed. SADA deals with the vertical
direction by allowing you to define a vertical layering scheme. This layering scheme is then used
in modeling and visualization alike. In this layer box, you can control which layer you are looking
at in the graphics window. You will learn a great deal about vertical layering later.

SECTION B — INTERVIEW STEPS

This is the interview steps section. When you select an interview in the interview box, SADA
responds by providing necessary steps to accomplish the objective as well as a number of
potentially interesting or helpful steps that might also be used.

~ X|

. See the data

. Set up the site
. Set GIS overlays
4. Set grid specs

. Interpolation methods

. Choose helper data

. Assess helper data

. Correlation modeling

. Search neighborhood
. Show the results
. Autodocumentation
. Manage model results
. Cross validation

4. Format picture

15. Export to file

Show The Results

When you click on any given step, the parameter window (Section C) changes to display
questions or options related to that particular step. The relationship does run both ways. Certain
answers or options in a parameter step may affect which additional steps may be needed. For
example, if you select ordinary kriging (a geostatistical method), the interview steps expand to
include correlation modeling (an interim step important to ordinary kriging).

SADA will attempt to carry out the objective of the interview when you visit the Show The
Results step or press the Show The Results button.

SECTION C - PARAMETER WINDOW

10
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The parameter window’s contents are dependent on the currently selected step. The following
image displays the parameter window for the Interpolation methods step (when Ordinary
Cokriging is selected in top drop-down list).

= Interpolators B|

|Ordinary Cakriging ﬂ Help

Modeling Options
Geostatistics provides two options for estimating
the value at any given point.

The mean is the kriging estimate for ardinary
kriging and the E-type estimate for indicator

kriging. This is the most popular choice for
interpolation.

Percentile returns the concentration values
associated with the specified codf percentile.

* Mean

" Percentile |55

¥ Use this percentile for all contaminants

Type of Cokriging

Intrinsic Coregionalization (Easy) ﬂ

Data Transfarm

@ Unit transform (0 mean, variance 1)

" Mo transfarm

Intringic Maodel Variable for Correlation Modeling

Primary ﬂ

The parameters for each step are discussed under the help topic associated with specific steps.
SECTION D — GRAPHICS VIEWER

Virtually all graphical results will be shown in this window. The graphics viewer is a very
powerful tool and discussion of its features is handled throughout the help file.

11
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SECTION E — MENUS AND TOOLBAR BUTTONS

This section is comprised of the menus and toolbar buttons. The menu section in particular
changes with the type of analysis as well as data type.

File Graphics Data Setup Reports  Statistics  GIS Export Tools  Help

] = EAL ] S A RSN EN N [

Each of these interviews, toolbar buttons, menus and so forth will be introduced as we go along.
For a quick reference, we recommend you use the SADA help file. The Help file is organized
around topics (e.g., Tools menu) whereas this user’s guide is organized more around
applications (e.g., determining where to place new samples).

See Chapter 2, “A Quick Tour,” for a quick flyover of SADA.

12
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Chapter 2: A Quick Tour

We will now take a quick tour of SADA, showing you very quickly some of the major features
and lines of thought people have often taken when using the code. This will familiarize you with
what SADA can do and also give you some practice moving around in the software. Each of
these features will be taken up in great detail later. If you haven't already done so, open SADA
and open the file Twodimensional.sda (File>Open). It should be located where SADA was
installed (probably c:\Program Files\SADA 5).

Virtually all spatial data exploration, spatial modeling, and any results that are based on spatial
outcomes are organized and made available to you through interviews. SADA “interviews” you
to acquire the information it needs from you and then carries out the objective you had in mind.
You are “interviewed” through a series of logical steps one would follow in order to accomplish
some task. Each step in the process presents you with questions or options or both that you will
need to answer as you go along. Some steps may actually run small interim models that are
needed prior to the final result. Let’s run through a couple of interviews to get a feel for what
each entails.

Suppose you have some environmental data, measurements taken in the soil on a particular
contaminant of interest. You would like to interpolate these data to create a continuous map of
contaminant concentrations. There are a series of questions you need to answer to accomplish
this:

o What data are you going to use?

¢ If your data are 3d, what type of vertical layers do you want in the interpolation?
¢ Do you want to focus on specific areas of the site?

¢ What type of grid would you like to use in interpolating?

¢ Which method of interpolation do you prefer?

After you have generated an interpolation map, there may be some follow up questions that are
helpful, such as:

¢ Would you like to format your picture?

¢ Do you want to store these results?

13
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¢ Do you want to make a quick report explaining how you got this result?
Let’s work through this using Twodimensional.sda as an example.
Click on the interview box down arrow and select Interpolate my data.

Fe Graphics Data Setp Reports Statistics GISExport Tools Heb
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| Show The Results
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# Use maximum
 Use average
 Use minim um

Non Detects

In the steps window (blue box) is a series of steps to go through to interpolate your data. Look
them over and see what types of questions correspond to what steps.

. SADA (C:\Program Files\SADA\Twodimensional.sda)
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Mon Detects

Click on each step and you will see the parameters window change to reflect the types of
information the step is asking for:

1. See the data (What data are you going to use?)

2. Set up the site (What kind of vertical layers might you have? Do you want to focus on
any particular area in the interpolation?)

3. Set GIS overlays (Do you have GIS layers like roads or photos to add?)

Set Grid specs (What type of grid do you want to use? — grids are the backbone of any
interpolation.)

Interpolation methods (What type of interpolation method do you prefer?)

Show the results (Run the interpolation. Really a command more than a question.)

14
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This first set of steps really leads up to the function. The Show the results step represents a
break between what you have to do and what you might like to do after the fact. The steps that
follow afterward are “after the fact” steps you might want to consider.

For our example, before you press the Show The Results button, make sure you have selected
Natural Neighbor in the Interpolation methods step. This is the easiest interpolation (estimation)
method in SADA. To do this, click on the step 5, Interpolation methods. In the drop-down
window, switch to Natural Neighbor. Press the Show The Results button or click on the Show
the results step (they do the same thing). SADA completes the interpolation, turning the discrete
data map into a continuous data map that should look something like this:

You've just created your first geospatial map!

Each interview has its own series of steps. The first two or three steps are the same for many
interviews (i.e., See the data, Set up the site, Set GIS overlays). SADA remembers the answers
to these, so you don’t have to revisit them every time you switch to a new interview (unless you
need to make a change). Some questions SADA asks ARE NOT dependent on any particular
data set or interview. For example, if you import a GIS layer called Roads.dxf, you probably
want to use it no matter what kind of spatial modeling you’re doing. SADA recognizes this and
shows the roads layer for all interviews until you say otherwise.

Some questions SADA will ask you ARE dependent on the particular data set you are using. For
example, suppose you want to compare your data set with specified limits established by the
EPA. These limits are different for each contaminant, so you’ll need to answer this question at
least once for each contaminant individually. (Chapter 5, “Importing Sampled Data,” discusses
how SADA identifies separate contaminants.) SADA recognizes these types of questions and
answers, and does not assume the same answer for every data set.

Now let’s look at the “after the fact” steps:

7. Autodocumentation (Would you like to make a quick report that helps explain this
picture?)

8. Manage model results (Want to store this picture?)
9. Cross validation (Want to see how well the model did?)
10. Format picture (Want to pretty the picture up?)

11. Export to file (Want to dump this out into a file another system might use?)

15
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We've just skimmed through one interview on how to interpolate data to get a continuous data
map. Now let’s go through another interview called Plot my data. This is one of the more basic
interviews, and it is the default interview after you import sampled data. As we go through, we
will look at features of three steps that are common to many interviews and important when

setting up your site. Let’s begin by selecting the Plot my data interview from the Interview Box

Drraw & clata sereen map
Mohel spatial comelation

Calculate cozt ws cleanup

Notice that many of the steps for this interview are the same as those for the Interpolate my
data interview.

[ SADA EE) s

Fle Graphcs Dats Setwp Feports Staletics GISEwport Took el
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v

Let’s start with the first step and go through them in a little more detail.

See the data gives you control over the data with which you are working. The parameter window
is divided into sections. Date Query lets you choose all data or a subset with a given date range.
The Duplicate Data section lets you decide how to deal with data from duplicate samples.
Finally, the section on Non-Detects lets you specify the value to be used when the measured
value is below detection limits. Essentially, this step defines how SADA will query and resolve
your sample results for the data set with which you are working. In this case, we are working
with Ac-225 measurements in the Soil.

& x| |
Date Query
@ Al

 Interval 264197010 BTMI9E (2 =
Akl Delete

Duplicate Data
 Use all values

@ Use oy detected valuss.

" Use most recent value

" Use most recent detected value.
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& Use maximum
" Use average
" Use minimum
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7 Use the full cistection imit

™ assume lognormal

Help

Set up the site is where you will define the horizontal and vertical extents of your site. You can
set vertical layers, set site boundaries, and use different shape features to include or exclude
parts of your study area. In particular, the site boundary section allows you to specify the extent
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of the site based on coordinates, by manually drawing the boundaries on the map, or simply by
snapping the boundaries to the limits of the data. The section Set Vertical Layers lets you
specify various layer designs to be used in your analyses. In other words, you can define how
you will divide up the subsurface. SADA is both a 2d and 3d tool. If all you have is 2d data, then
simply specify surface only, for example.

The polygon section lets you spatially aggregate subsets of your data for analysis by drawing
features directly on the data map. These features can be rectangles, ellipses, or polygons, and
they can be used to define irregular site boundaries as well as focus in on certain areas of
interest while excluding others.
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Set GIS overlays allows you to pull in GIS layers to display with your data. In this example,
we’ve imported layers with roads at the site and an aerial photograph. You control how and
whether the layers are displayed. You can hide all layers or select or deselect individual layers
by clicking the associated boxes. The Properties button lets you change layer colors and draw
widths.

% GIS Overlays X

v SADA Resut

¥ higgerview

Apply | Remave| A ‘ Properties ‘ﬂﬂ
Help

[™ Hide layers
[~ Show spatial axes wih GIS

We've taken a quick look at the Interpolate my data and Plot my data interviews. Now, suppose
you want to see which samples from your site exceed some threshold level. The Draw a data
screen map interview is designed to give you a quick route to visualize both the number and
distribution of exceedances at your site. To see how it works, select Draw a data screen map
from the interview list.
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File Graphics Data Setup Reports Statistics  GIS Export  Tools  Help
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Again, notice many steps here are the same as for Plot my data. We don’t need to revisit the set
up steps, but step 4, Set decision threshold type is important (more on this later). Select Set
decision threshold type and the Decision Threshold choices will pop up.

See the data

. Set upthe site oo q o
. Set GIS overlays *x Decision Threshold Criteria
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. Showthe results Decizion Threshald

. Autodocumentation
. Format picture
. Export to file
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Click the Show the Results button and SADA will ask you to specify a decision goal. Here our
goal is 3pCi/g. We got this number from some outside source. It could have been calculated
outside SADA, or it could be part of some regulatory guidance. At any rate, this is the screening
value. SADA has more sophisticated ways to import screening criteria or calculate it for you.
You'll learn more about these later in Chapter 14.

Click OK and a box appears telling you 10 stations exceeded the decision goal. Clicking OK
again results in a data map with boxes that mark stations with values >3.
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Just a note about units: SADA does not force or expect any particular type of unit for measured
values. You are responsible for making sure all your data is in the units you expect. The only
exception for SADA is when you are doing human health risk or ecological risk. In those cases,
SADA assumes your measured values are in pCi/g, mg/kg, mg/L etc. See the risk chapters

(Chapters 17-27) for greater detail.

You might notice that the black boxes around those points exceeding 3pCi/g are difficult to see
with the dark photograph in the background. This is easy to fix. From the main menu, select
Graphics—>Set Various Colors-> Screening Box. Choose orange as the color. You should see

the boxes more clearly now.

Suppose you want to see not just which stations exceed a criterion but what area on the map
would be predicted to exceed the criterion. SADA combines the concepts behind the Interpolate
my data interview and the Draw a data screen map interview into the Draw an area of concern
map interview. An area of concern can be defined in different ways, but the underlying meaning
is consistent. An area of concern is a spatially defined portion of the site that is causing a
concern because it is in exceedance of a decision criterion or is significantly contributing to a
decision. For environmental applications, this is usually viewed negatively, as it represents an
area that might require some sort of remediation or intervention. For mining applications, this
might represent a lucrative body of ore. Either way, it represents an area of interest to the

investigator.

|Draw an area of concern map

Draw a probability map

Diraw an area of concern map
Calculate cost vs cleanup
Dirave a LISA Map

Develop zample design
Perform geostatiztical simulation
Smooth/reduce borehole data
Add data to my file

Draw an area of concern map contours the data and then shows the region on the map that
exceeds the criterion. From an environmental viewpoint, the result is an area of concern map

that can be used in setting remediation boundaries.

Let’s take a look at the steps available for this interview. They should look familiar since they
contain many of the steps already seen for Interpolate my data and Draw a data screen map.
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Some important new steps appear between steps 4 and 7. At the fourth step, we have a
question about the grid specification. You'll learn later that contouring algorithms rely on
specifying a grid that is stretched across the study area. Then, the center of each cell is
estimated, forming a continuous map. You can make the cells as small or as large as you like,
and there are different motivations for choosing one cell size over another.

Click on Set grid specs. You can see that we've set grid specs at default of 50 cells x 50 cells.
Click on the Interpolation methods step. Make sure this is set to Natural Neighbor again. Click
on Specify decision criteria. This parameter window contains quite a few options for defining
decision maps. We'll accept the default choices there and continue to the step Set decision
threshold type. In SADA 5, you can choose a single decision criterion or specify the decision
criterion as a function of depth. In our case, we will choose to go with a single decision criterion.
Press the Show The Results button and enter a value of 3 when prompted.

Name: Ac-225
Tile: 4225 frea o €
Type:  AOC Map

Units:  fest

Layers:

——— Roads

4.90E+00
4.08E+00
3266400
2 44E+00
162E+00

6.00E-0

Prepared by: Company &  Project Project One [ —rr e —| 2eUNIVERSITYor
ar: john

me Fri al TENNESSEE 13

where you can type amyvthing. There is quite a lot of room available and by controling the heiott of the memo

{PLT ¥OUR | OG0 HERF)

The area in gray represents the area of concern. The thick black line represents the current
boundary on the area of concern. Later, you will learn how to visualize uncertainties about the
boundary on the area of concern.

SADA also computes a volume estimate for the area of concern. This appears at the bottom of
the screen when the area of concern map appears.

Clean 782 blocks. Wolume = 1286390 cubic [zquare for 2d] unitz. Masz = 1286330

The number of blocks to clean for a block scale analysis is the number of grid cells estimated to
exceed the decision goal. Volume is computed based on the units used to plot the data (i.e.,
cubic feet, cubic meters, etc., or squared units if the data layer does not include depth). Mass is
computed using assumptions on the density of the material to be removed. In this example,
mass = 1.
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So now we've estimated an area of concern based on a decision goal of 3 pCi/g. What are the
costs of cleaning up to this level? How would cost change if the goal were raised or lowered?
The Calculate cost vs cleanup interview provides you with the means to answer these
questions. Select this interview now.

Calzulate cost we cleanup i

Ciraw a probability map
Draw an area of concern map

Calzulate cost vi cleanup
Crraw a LISA Map k
Develop sample design

Perform geostatiztical simulation
Smooth/reduce borehale data

&dd data to my file b’

The only step we haven’t seen yet is step 7, Set cost information. This step allows you to set the
cost/unit volume (i.e., $/cubic foot) of removing the contaminated media and of removing
uncontaminated overburden.

*x Cost Parameters

Cost per Unit “olume

Contaminated Media Cost 1
Overburden Cost 1

Mate that your cost is costiunit volume. Far example, if vour coordinate
zystem is in feet vour cost should be ertered as the cost per cubic foot
[per sguare foot far 2d).

Press Show The Results button and you will see a cost-benefit graph like the following.
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This graph is very useful in showing how small changes in the decision criteria can result in
large changes in cost. For example, in this plot, the cost changes very dramatically between 1.8
pCi/g and about 2 pCi/g. Later, in the chapter on assessing cost (Chapter 36), you will learn
about some tools for interpreting and reading this graph.

Let’s continue to follow this problem out. We've interpolated the data, determined an area of
concern, estimated volume and cost of clean up. One thing we might want to do is take some
samples to improve the area of concern calculation. The Develop sample design interview
assists you in deciding where to place additional samples to get the most “bang for your buck.”
From the interview box, select Develop sample design.

Develop zample dezsign -

Crrawe a probability map ~
Drraw an area of concern map

Calculate cost ve cleanup

Oraw a LISA Map
Develop zample design
Perform geostatistical zimulatio k
Smooth/reduce borehole data
Add data ko my file i’

Looking at the list of steps for this interview, we see Set sampling parameters is the only new
one. This allows you to select the sampling design you would like to use.
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. See the data

. Set upthe =ite

. Set GIS overlays

. Set sampling parameters

. Set grid specs

. Interpolation methods

. Specify decision criteria

. Set decision threshold type
. Show the results

1
2
3
4
5
[
T
8
9

10. Autodocumentation
11. Format picture
12. Exportto file

Show The Results

Chapter 2: A Quick Tour

In this example, we want to improve our estimates around the area of concern boundary, so
we’ll select that as our sample design and fill in the appropriate parameters.

Judgmental
Threshaold Radial
Adaptive Fill
Ripley's K
foran's |
Geary's C
Highest Yalues

Area of Concern Boundary

The parameters window allows you to specify features that will control where the samples are
placed, whether to design core samples or single point samples, the number and spacing of
samples, and how to decide between two locations when they are tied for the next best place to

sample.

“x Sample Design

Sample Design

ern Boundary

Locates samples where interpolant's estimstes are closest to
decision criteria.

Care vs Single Point Sampling

[~ Design core samples

[™ Show ghost image of new samples found on ather layers
Mumber of Samples
&+ vou pick ’15—
" Based on Sign Test

™ Based onWicoxon Rank Sum

W Separate by o least g
Tie Break Options
% Random Seed (optional)

7 Maximize spatial coverage

" Closest to certer of ste

Help

%
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Enter 15 for the number of samples. Make sure you've selected Separate by at least and enter
a value of 100 for this option (more on this in Chapters 37-39). Press the Show The Result
button, enter a value of 3 for your decision criteria and you should see a result similar to the
following image.

Name Ac-225
Tl Mew Ac-225 Sanples

£

Prepared by, Cons A Pr P On P mal INIVERSITY ol
e b G o Val TENNE:-L‘-:EE_.'

00 Teet

" s isihe memo fiekd where you can bypse SRR, THere i aube & Jot 68 rom svadabie snd iy CORIIONNG the herght of the Mama fieid even more can b
X ahied. [FUT YOUR OGO HERE}

The graphic now shows triangular shapes where new samples would optimally be located to
better bound or investigate this area of concern. Notice they are not necessarily uniform. This is
because the model needs more information in certain areas than in others.

There are many, many other features that SADA provides not included here in this flyover.
Hopefully by now you are starting to feel more comfortable switching between different
interviews and perusing through some steps. In the next chapter, we’ll start from the beginning
and closely investigate what all this really means.

If you wish to take a break, you can close SADA now by selecting File 2Close. Select No if
asked to save. If you are continuing, then you can keep SADA open.
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Chapter 3: Understanding SADA Files

Like many other Windows software packages, SADA creates and uses SADA files denoted by
the suffix .sda. With few exceptions, everything is stored in a SADA file. You can then easily
pass this file to other folks who can open it and see the work you’ve done. Any data you wish to
use is imported into the file (model parameters, risk parameters, decision parameters, and so
forth). Virtually everything that you create, import, or calculate can be found in your SADA file.

When you install SADA, a handful of SADA files are included in the installation to help you get
started using the code. Let’s start by opening a SADA file and see what it looks like. If you do
not have SADA open or the twodimensional.sda file open, please close SADA and follow the
directions.

Start SADA (e.g., Start>Program Files>SADA 5>SADAS or you may have the shortcut on your
desktop). The SADA icon is as follows

The first time you open SADA you will be presented with the welcome screen.

=x Welcome to SADA Bj

SADA Files
" Create a new file
@ Open existing file

C:h L ficial SADA 5 Development\Main Development

Twodirnensional. sda

Browse

[~ Don't show me this again

(a]74 | Close | Getting Started Tutorial

If you do not see this screen, continue reading to find out what you should do next. If you do see
this screen, then it is easy to create a new SADA file or open an existing file. Finally, if you do
not like this welcome screen to show up each time, select the “Don’t show me this again option”
and press Close (don’t do this for now).

For now, let’s open the file Twodimensional.sda. Select the Open existing file option. Use the
Browse button to navigate to the Twodimensional.sda file location. The file should be located in
the same directory where SADA was installed. If you are unable to find your installation files,
you can access them again by visiting the SADA website
(http://www.tiem.utk.edu/~sada/index.shtml).

If you did not see this welcome screen, it means that someone has previously selected to turn
this option off. To make sure you see it in the future, simply go to the menu path:

Tools>Show Open Dialogue at Startup

The next time you open SADA, the welcome screen will appear. In the meantime, you will select
Files>Open from the main menu. Navigate using the open window dialogue to
Twodimensional.sda and press Open.
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The SADA file is now opened and you should see something like the following (depending on
your version of Twodimensional.sda, you may see a more graphically rich display).

“w SADA (CAAlRcbertsFiles\Official SADA S DevelopmentiMain Development\Twodimensional. sda)
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Easting

At the top of the SADA interface is the name of your SADA file (Twodimensional.sda). Much of
the rest of SADA is now enabled, and you can see the first contaminant in the data set (Ac-225).
If you need to refresh your memory on the SADA layout, revisit Chapter 1.

What does it mean to edit your SADA file? Well, we’ll now make a trivial change so you can see
what it means. On the left hand side of the screen is a blue window called Steps. You should
see a step called Format picture. Click on this step.

*w Format g

Format

@ Picture Title
© Honzontal Title

€ Vertical Title
© Horizontal Axis
© Vertical Axis

 Legend

Click on Fomat Step 2:
Eprtmat Fou (A \ Add the
icture = text
TEST to
the end.

Apply
Step 3: /‘
Press Apply./

The window on the right will change. This is the parameters window, and it adjusts itself to
reflect whatever step you are on. You can learn more about this later. In the parameters
window, there is a text box called Caption. Add the word “TEST” to the end of the text you see
there. Press the Apply button. Notice in the graphics window that the title of the picture has
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changed and now includes the word TEST. This is part of the format feature, and you can learn
more about this later.

Ac-225 Samples TEST E
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| | 1
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Easting

Now select from the main menu File »Save As...
Save the Twodimensional.sda file as MyTwoDimensional.sda.

Now select File» Close.
SADA asks one more time if you would like to save the file. We just saved it, so say NO.

Now select File>Open, and navigate to where you saved MyTwoDimensional.sda.
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Look in: |r_}5-ﬂDﬁ~ ﬂ & B e
. Cyecosupport
i Ea CIMyFIrstReport
My - REkModets
Recent i
il jTmemmE:ﬂsmdﬁwlmﬂ sila —
Deskiop
Wy Diocuments
My Computer
File name: |‘.sdu ﬂ | Open |
My ﬁﬂmm Files of type: |SADA File (~sda) ~] Cancel

Select MyTwoDimensional.sda and press Open.

Notice that the modification to the content of your project ("TEST") was saved.
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This is a very trivial example of how a .sda file stores everything you do in SADA. The important
thing to know about SADA files is the following: Nothing is stored in the SADA file until you save
the file. This is consistent with common Windows applications such as Excel or Word.

Any data that you import into the SADA file is completely contained within the SADA file. What
this means is that any changes to the data you may make in the SADA file DOES NOT affect
the original data file or database from which it came. The change is only internal to the SADA
file. Conversely, any change in the original source file or data base will not affect the data
values in the SADA file.

Throughout SADA, you will have opportunities to import a variety of things, such as toxicity
values, custom screening values, ecological benchmarks and so forth. These values are copied
and brought into the SADA file just like data. Therefore, any changes to these parameters done
inside SADA are not reflected in the original file or data base. The converse is also true.

New Files

You can also create a new SADA file very easily. From your welcome screen, press the New
button. Or alternatively, from the main menu, select File sNew.

You will be presented with a Windows Save dialogue box. Enter a name for your SADA file
(e.g., MySADAFile.sda) and press Save. SADA will respond by creating a "blank canvas" SADA
file. The file is essentially empty because you have not brought any data into it yet. Therefore, a
lot of functions are disabled.
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You can do a few preliminary things, such as set up your site, bring in GIS layers, or create a
new sample design. You'll learn more about these in the next chapter. If you like, you can close

your SADA file now (File *Close) and choose to not save.
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Chapter 4: Setting up a SADA File

Let’s start out by creating a brand new SADA file. This is very easy to do. Setting up the site
after the file has been created, however, can take a bit more effort. When you first start, there
may be some data already collected that can be used to help setup site boundaries, establish
vertical layers, and so forth. Other times, you may not have any data but want to set the site up
to perhaps create an initial sample design. In either case, the way you create a SADA file is the
same and is relatively easy. When you have data available, there are some extra handy tricks
(see Chapter 5, “Importing Sampled Data”).

Let’s start with the very beginning - you have no data and you want to create essentially an
empty SADA file. There are a lot of things that can be done in a file that has no data. You can
set horizontal and vertical extents of your site, bring in GIS overlays, and set boundaries of your
site with the polygon tools. You can also develop an initial sample design that can be exported
and submitted to the sampling team or import existing data.

Create a SADA File

If you do not have SADA running, open it up now. At the Welcome Window, select Close. If you
already have SADA running, make sure you close out any file you may now have open by
choosing from the main menu File 2Close. If asked whether you would like to save or not say
No.

From the main menu, select File 2New. Navigate in the explorer window to where you have
installed SADA. This is likely C:\Program Files\SADA 5 or something similar. In the file name
box, enter the name MySADAFile.sda and click Save. SADA will go through a creation process
and present you with a blank file. SADA will look something like the following picture.

il = [ ] (G5 i Nt |

- —

Only Two Options in a
Empty File

‘ Dummy Site

hartrarg ’
t + + + 5

The interview box will only have two interviews: Setup the site or Develop a sample design. The
graphics window will show a dummy site. SADA needs to show something in the graphics
window, so it starts you off with a dummy site on an arbitrarily selected coordinate system of 0-
1000 in both the easting and northing direction. Next, we’ll show you how to setup a meaningful
site.

Notice that you are automatically in the interview Setup the site. If you are not on this interview,
switch to it now. You are automatically set to the first step in the interview, which right now is
Display empty plot. The first step in any interview is usually an action step, meaning if you click
on it some action is immediately taken. In this case, every time you click on the first step, it
immediately redraws or refreshes the empty plot.
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Let’'s move to the Set up the site step. Here is where we can change our dummy site into
something useful. This is done by specifying the bounding box, called the “site boundary.” It is
not likely that your site is a perfect rectangle. That's OK. This is really just a bounding box that
needs to be big enough to encompass your entire site. You can use the drawing shapes found
further down to really define the boundary of your site. So to get started, all we need to know is
the coordinate boundaries for our site. Unfortunately, we often may not know this right off hand.
We could also set up our vertical layering scheme, but this is usually secondary to getting the
horizontal extent correct. If we don’t have a horizontal bounding box, we can’t draw any
meaningful polygons. If, for some reason, you do know the coordinates for your set and can
enter them in now, you are in luck and you should definitely do so. But for the rest of us, what
can we do?

We need some context; that is we need a map or a photograph to use as a reference. Then we
have a good chance of recognizing our site and being able to realistically define it for SADA. If
you don’t have a map or any kind of photograph, maybe you have some sample points to
import. They might provide you some context for setting the boundaries of your site. We’ll show
you how to do that next. For now, we’ll assume you have no data, and we will move forward
without it for now.

To get some context, we need to look to the Set GIS overlays step. This is the third step, but we
have seriously considered moving it to the second step as this is often where users go first.

Working with GIS Layers

SADA can read and use map layers that have been produced by a Geographic Information
System (GIS) and saved in a Data eXchange Format (.dxf) or Shape File (.shp) format. For
example, one layer may show all roads and another may show all buildings. In addition, SADA
can read and overlay photographic/raster type images such as .JPG, .GIF, .TIF, and .BMP files.
These photographs can be dropped onto a site and shifted/stretched/compressed to match
existing GIS or data layers. SADA does not allow users to edit or query GIS layers. They serve
strictly as maps to provide reference. As a note to GIS folks, SADA can also import raster
images such as geospatial models and elevation in a ASCII raster format or a ESRI grid format.
Elevation can also be brought in as a Digital Elevation Model (DEM). This type of layer can be
used directly in SADA decision and modeling processes and is considered separately from the
types of layers presented here.

Set GIS overlays is one of the basic steps and is usually step 3. Click on this step now and
SADA will display the parameters window.
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. GIS Overlays 3

| =204 Result

] 14

Zoom Tao Layer | Helg |

[ Hide layers
[ Show spatial sces with GIS

To add an overlay, press the Add button. SADA can import Data eXchange Format (.dxf), shape
format (.shp), .jpg, .gif, .tif, and .bmp files. In the explorer window, make sure the Files of type
option is set to Data eXchange Format. Select the roads.dxf file and press Open. Repeat this
and choose water.dxf as well.

Look in: | 5 54D4 =l o E-
Iy ) debra
'Y b ICecosuppart
MyRecent  |3RiskMadels
D'ocuments ) SabaReport
?L' roads
water, dxf
Desktop
My Documents
kdy Computer
‘g File name: |r|:|a|:|s.-:|:-cf ﬂ D=ty |
by Metwork,  Files of type: |Data exchange Format [.dxf] ﬂ Cancel |
Flaces [ Open az read-only

After adding overlays, the parameters window will look like the following.
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™ GIS Overlays

SADA Result
v| Roads
| Water

Bpply [ A mapn

Zoom To Layer | Help |

[ Hide layers
[ Showe spstial axes with SIS

Chances are pretty good that you don’t see anything but a blank graphics screen. This is
because the coordinates for these two map layers are nowhere near the 0-1000 easting and 0-
1000 northing range. This is a common problem in any GIS system, that is, matching
coordinates properly. We don’t really need to match our 0-1000 dummy site to anything
because it is, after all, a dummy site. What we want to do is find the layers we just imported. To
do this, select Roads in the parameters window and press the Zoom To Layer button. You
should see something like this:

Move your mouse over the picture and notice in the lower-left-hand corner that SADA is
reporting the exact coordinate of your mouse pointer. Notice that these are nowhere near 0-
1000. This means that our dummy site is way off in the lower-left-hand side way out of view. We
haven’t yet changed our site. We’ve only shifted our view to the GIS layers we just imported. We
can use these layers to get some kind of reference for where our site resides.
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Right now though, both the roads and the water layers are colored in black. Let’s take a look at
the properties feature of each layer. Click on the Properties button. In the window that comes
up, choose Water.

®u Layer Properties

Filename

C:%Program FileshSADdE B0 ater. dxf

Layer Type
Di=F File

Laver Properties

Calor - Edit

Diraw width -

oK

SADA provides you with some useful information in this window. First of all, we see the original
location of the .dxf file for water. Note that SADA has copied this file and added it to your SADA
file. So, SADA isn’t actually using this file anymore. Any changes to this file will not be seen in
SADA until you reapply it. We see that it is a DXF file. Below that are the layer properties we
can change. To change the color, press the Edit button and change the water color from black
to blue. Press OK. To change the draw width, type a number in the box or select one of the
predefined sizes. Press OK. To see the changes apply in your graphics window, press the Apply
button.
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To remove an overlay, select the overlay and press the Remove button. To make an overlay
visible, check the box next to the name. To turn off the GIS overlay altogether, click in the box
next to Hide Layers. Repeat this process to turn the GIS back on (Hide Layers will be
unchecked).

Setting Site Boundaries

Let’'s now define the real site of interest. First, make sure the graphics viewer still shows the
roads and water layer. If it doesn’'t show anything for some reason, in the parameter window,
click on Roads and press Zoom to Layer. Click on the step Setup the site.

So, let’s spend just a moment for vocabulary. The left to right direction in the graphics viewer is
referred to as the easting, meaning this is the east and west direction. The up and down
direction is the northing, and it refers to the north-south direction. Now, the site boundary box is
defined as follows.

(Maximum Easting Coordinate, Maximum MNarthing Coaordinate)

<North South—>
(Northing)

<West East—>
(Easting)

(Minimum Easting Coordinate, Minimum Morthing Coaordinate)

So, we need to specify the minimum easting and northing value as well as their maximum
counterparts. We can do this in three ways. First, if we know them, you can just type them in
and press the Apply button (don’t try this now). Second, we could draw them. This is the one we
want to demonstrate now.

To draw your site boundaries, press the Draw button and move your mouse over your graphics
viewer. To draw, choose a place on your map, then left mouse click down and hold it. Then,
move your mouse around and you will see a brown box open up and follow you around. This is
your site boundary box. When you have it sized how you want, release the mouse and notice
that the proper coordinates have been entered for you.

Easting [2688176
Northing [2175383
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Now you may have drawn your site differently, and that’s okay. When you release the mouse,
SADA snaps the site into view. In this demonstration, the following site was created.

Before you go any further, draw your site approximately like the one you see above. Then save
the file by choosing from the main menu File 2Save. Next let’s bring in a photograph.

Working with Photographs

While photographic/raster layers can be brought in the same way, they do not have coordinates
to orient them relative to the data or other layers (for example, TIFF files may have a
coordinates file, but SADA won’t use the coordinate information at this time). It is definitely
important to have your site boundary box setup before you proceed with bringing in
photographs.

You can bring in any type of photograph. In the examples we present here, we simple did
screen captures of Google Earth and saved them as .jpg files. To show how this works, return to
the Set GIS overlays step and click on Add again. Navigate to Program Files\SADA 5.0 and
change your file type options at the bottom of your open dialogue to .jpg. Choose biggerview.jpg
and press open. When a photographic or other raster type image is added as a layer in SADA,
the image is dropped directly onto the site without any reference. This is just the starting point.
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Gt 19 7]

First, let’'s change the color of the roads layer to red so we can see it better against the photo
background. Click on the roads layer, push the properties button, and change the color to red.

Now let’s talk about zooming, shifting, and restoring a bit. You'll find these features on the main
toolbar.

Zoomiln ‘/Zoom Out
SN |

Shift Picture /

Restore

The Zoom In and Zoom Out buttons work much the same way as drawing site boundaries. To
try it, press the Zoom In button. Most of the SADA interface will become disabled (SADA
doesn’t’ like you multi-tasking). Move your mouse over the graphics window. Then, left mouse
click down and drag open a zoom window. Zoom Out works the same but makes the view
wider. To use the shift feature, press the button with the hand on it. When you move your
mouse over the graphics window it will turn into a hand. Left-mouse-click down and move the
image around. When you release the mouse, it will refresh the image. Now if you really lose
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yourself in all this and want to get back to your site, press the Restore button. Press the Restore
button now.

Now back to photographs. First, zoom out a little so you see all the road features you see in the
following image.

Y

Select the biggerview layer from the parameters window, and the parameters window will
display the photographic geocoding options available in SADA.
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™w, GIS Overlays B|

vl SADA Result
v Roads
vl Water
M biggerview

Apply Rermave Add Propetties ‘LL

Help |

Zoom To Layer

[ Hide layers
[~ Show spatial axes with GIS

Photographic Geocoding
Translation Manual

=) T 41~
| =@ =- O 2D
'8 l -»:«:-H-

™ Show pin Properties

Transparency

Clear Salid

There are a number of features here that allow you to shift, stretch, and otherwise position your
photograph. It is a bit overwhelming at first, but really the only feature you need to know is the

rubber sheeting function accessed by the button @ :

Rubber sheeting translation allows orientation of the photograph by graphically specifying the
location of two points. This is the recommended approach and can likely better orient your
photograph than any other positioning tools found in SADA. Essentially, you match up a pair of
points on the site, and the picture is reoriented to match the rest of your data.

To begin geo-referencing our photograph with the other layers, we first need to locate points
that appear on both the photograph and one of the other layers (building corner, road
intersections, etc.). The following image shows the two points of interest in this demonstration.
The yellow arrow connects the T intersection in the photograph with the T intersection on the
Roads layer. Similarly, the blue arrow connects the corner of a parking lot with that same corner
on the Roads layer. Before you begin, make sure you are zoomed out enough to see both of
these locations in both the photograph and the Roads layer inside your graphics viewer.
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Next, click on the rubber sheeting button @ in the parameters window. SADA will prompt
you to start rubber sheeting. Click on a point in the photo and draw a line by moving the cursor
to where the point should be. It is important to remember during the rubber sheeting process to
click on a point in the photo and draw from it to the other layer rather than moving a point on the
other layer to a location on the photo.

At the prompt, click OK. Then, click on the T intersection of the photograph.

Drag the line over to the same T intersection on the Roads layer and click again.

SADA pops up the coordinates of the point. Click OK. You'll then see a prompt to specify a
second location for rubber sheeting. Click OK, and you’ll see the photograph has been
reoriented to match the first point you specified on the photo to the location on the Roads layer.

Now click on the edge of the parking lot in the photograph.
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Drag the line and click on the same corner of the same parking lot in the Roads layer. Be
careful.

After you click on the location where the second photograph point should be, you'll see a
window with the coordinates for that location. Click OK, and SADA will redraw the image,
stretching the photograph such that the first and second points you specified on the photograph
now fall at the locations you specified on the Roads layer.

If you made an error, you are in good company. You can do one of two things. First just repeat
the process again. But if things are really out of line, press the photograph restore button. This

is found on the parameter window and looks like a bull’s eye .

This will reset the photograph into your site boundary box. An easy mistake to make is to do the
reverse. That is, select the location on the GIS layer and draw it to the correct location on the
photo. This mistake can lead to some surprising (and even disorienting) results.
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Another feature is the transparency control. This feature allows you to control how well you can
“see through” the photograph. This is useful if you should need to overlap photos. For example,
one photo may be actually taken from an on-line road map service, like Map Quest, and a
second photo might be from an old engineering drawing.

The remaining geo-referencing tools on the parameter window are intuitive and are discussed
quickly. If you are not able to use rubber sheeting to align your photograph, you are not likely to
succeed using these tools either. These tools were intended to be refinement actions to make
very fine-tuned adjustments.

The buttons are described briefly as follows.

- shifts picture up.

- shifts picture right.

- shifts picture down.

- shifts picture left.

- restores picture to default orientation.

- sets a pin point on the map where all expansions originate from.

- stretches equally in both directions from the pinpoint location.

- stretches equally in up/down direction from the pinpoint location.

- stretches equally in left/right direction from the pinpoint location.

- rotates clockwise around pinpoint.

- rotates counter-clockwise around pinpoint.

D=k @[Tl =

4
*‘I‘

- contracts equally in all directions relative to pinpoint.

+
‘I‘*

Y

- contracts vertically relative to pinpoint.
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»

- contracts horizontally relative to pinpoint.

When the show pin box is checked, the location of the pin point around which you are rotating
and stretch/shrinking will be displayed.

The properties button under this set of tools will allow you to set the distances that you shrink,
expand, or move with each button push. Similarly, you can set the angle you would like to rotate
with each push of the button. The smaller these values are, the more refined your adjustments
will be. You can also control the color of your pin-point when it is displayed.

*u Photo tool prope... |:|B‘
Shift
Expand/Shrink. 47
Fotation [deq) 1

Finpaint calar Edit

Help K

O

GIS/Photograph Tips

It can be complicated to geo-reference a photograph to other data layers if the scales are
disparate. Something to consider when you first pull a photograph into SADA is whether you
can see specific points on the photo and another layer to use in geo-referencing. In this tutorial,
the scale of the site is much larger than that of the photograph, making it more difficult to find
matching points. A simple solution is to remove the photo layer, broaden the site boundary, and
then re-import the photo layer. When the photo drops onto the larger site, you should be able to
see more locations--road intersections--for instance, to use in geo-referencing. Having the
scales more similar from the start makes geo-referencing easier.

It is helpful to set up the site boundaries prior to importing the photographic layers, as this
defines where the layer will appear. If no site boundaries are set, the layer will appear in the
default 0-1000 easting/northing, which may not coincide with the location of data or other layers
for the site.

The GIS overlays parameter window shows the current layers in order of priority. Thelayer that
appears first is plotted over those that appear later. If you pull in a photograph before pulling in
other GIS layers, the other layers will be plotted behind the photograph and you won’t be able to
see them. Use the up or down arrows in the GIS overlays parameter window to move layers up
or down on the list. Putting your photograph at the bottom makes it the backdrop for all the other
overlays.
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There is an unmentioned player here called projections. Because coordinate systems may be in
different projections, it is unlikely that your photograph will exactly match every feature in your
GIS layer. Even in true GIS systems with projections accounted for, there will be small
discrepancies. This is unfortunately the reality of GIS tools and the quality of the data they are
required to use. What is important is to match the photo as well as possible to the area of
interest. Because of these discrepancies, we DO NOT recommend that you use geo-referencing
of this sort when it is extremely important that the photo or layers are exactly positioned. If
issues of safety arise (e.g., things like gas lines, highly dangerous buried contaminants, etc.),
you should not rely on this method but rather turn to a true GIS system with extreme local
accuracy.

Finally, sometimes GIS layer order matters. Sometimes the SADA result will be a contour result
and may hide the road or water layers. In this case, you’ll want to use the up and down arrows
to specify the order in which the layers are displayed with the layers higher on the list being
plotted on top of the layers below them.

SADA doesn’t automatically show the spatial axes associated with the plot when displaying GIS
layers. If you want to see the axes with the GIS layers, check the box.

Setting Vertical Layers

SADA is ultimately a 3d tool, so it is a good time to talk about how we deal with the subsurface.
We've spent a great deal of time on how to establish the horizontal extents. There are times
when you will need to deal with the 3d extents as well. Unlike the horizontal direction, the
vertical direction is divided into layers.

In the following picture, you see a vertical layering design that divides the subsurface into the
first half foot, then the next 1.5 feet, then 2-8 feet and finally 8-12 feet. These measurements are
always relative to the surface (i.e., 0-0.5 means 0.5 feet from the surface; 0.5-2.0 means from a
depth of 0.5 feet below the surface to a depth of 2 feet below the surface). As always, the units
are not tracked by SADA, but they should match the same units as that in which the horizontal
is measured. For example, if the horizontal is reported in meters, then the depth should be
reported in meters as well.

In the image below, the layers have been visually separated so you can see them better in the
image. But in reality, they are stacked right on top of each other.

l
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Perhaps the most important thing to note about this design is that the vertical layers have
irregular thicknesses. The first layer is only %2 foot, meter, etc. The second layer is 1.5 units
thick and so forth. This is very different than many modeling packages where the subsurface is
divided evenly. From a risk perspective, this is particularly important as different exposure

scenarios are associated with different depths. For example, residential is typically associated
with the first 7% foot while industrial or worker scenario may be associated with the first 2 feet.
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Dividing the subsurface this way affects the visualization of data as well as the modeling
features. It is also possible to turn layers off and on. In the following picture, we see a
representation of the subsurface layers where active layers in blue are turned on. Gray or
inactive layers are turned off. If a layer is turned off, then data points found in that layer are not
considered in the analysis (an exception is for geospatial analysis, where you have the option to
continue including them even if you are not modeling the layer). So for risk assessment, the
data would not be included. For modeling, these layers would not be contoured. For decision
analysis, they would not be considered in computing the remedial volume.

p— R

0.5-2

0-5

= — Inactive
28

Inactive
8-12

A layer design is actually a collection of layers. You can create as many layering designs as you
like and assign each one a unique name. SADA comes with two special case layer designs.

The first one is called Entire Data Layer. This layer is dynamically created and maintained by
SADA. You cannot edit it yourself. This layer design is a single thick layer that is always large
enough to view all your data at once. This is especially useful when you are importing new data
and want to make sure your layers are deep enough to see all the data.

The second layer design is called Surface Only. This layer is always at depth = 0 and cannot be
changed. Certain features, such as the MARSSIM analysis, depend on its presence.

To make sure you are on the same page as this text, close out any file you might have open in
SADA and say No when prompted to save. If you do not have SADA open right now, go ahead
and start it and close out the Welcome screen.

Now let’s open the file MySADAFileWithGIS.sda. Recall that to open a file you choose from the
main menu File 20pen. Navigate to the location where SADA is installed and choose
MySADAFileWithGIS.sda. This file picks up where our previous file creation activities left off.

Click on the Setup the site step and notice the Set Vertical Layers section.

Set Vertical Layers
|En1ire Data Layer ﬂ Add

Surface Only 4

0-0 (Active with no polygons)

Interpolate and Flace New Samples

" At the top & In the middle

If you click on the layering design box you will see the two default layers. Let’'s add a new layer.
Press the Add button and you will be presented with the new name window.

46



Chapter 4: Setting Up a SADA File

"n Create New B‘
Mame of the Mew Layering Scherme :
|MyLayers|
Based On :
|New Layer Design ﬂ

Create Cancel

At the top of this window, type in “MyLayers.” This is the name of your new layering design.
Underneath this you can select a previously created design to use as a template for your new
design. For now, we’'ll just keep the selection “New Layer Design.” Press Create and you will be
presented with the vertical layering window.

™ Edit Layer Design g

Current Layering Design Details

From To Paolygon Active Remedial Threshold The table below allaws you to cantrol the behavior of
b4 jD 100 Naone ﬂ‘ves ﬂ|u each layer in this layering scheme.

From

The top of the layer measured as depth from
surface. Paoints with this exact depth value will be
found in this same layer.

To

The bottom of the layer measured as depth from
surface. Points with this exact depth value are not in
this layer. They will be in the next layer or if there
isn't a deeper layer, they are excluded.

Polygon

This is the name of the polygon layer you wish to
apply to this vertical layer.

Active

Turns a vertical layer an or off. If true, then the
layer is turnad off.

Remedial Threshold

In some situations, the user is allowed to specify a
decision criteria (8.0. scraening value, cleanup
criteria) as a function of depth. This is an opportunity
to specify those depth dependent values

Add I Delete I Check

Help I ok I Cancel ‘

On the left hand side is a single row of entry boxes. On the right is some explanation of what to
do. The window is fairly intuitive. You will enter values in the From and To columns to define
each layer depth. Press Add Layer to add a blank layer to the layer scheme. If polygons have
already been created, select the applicable polygon layer to display in each vertical layer (you
don’t have any right now). Specify whether you want the layer to be turned off by choosing Yes
or No in the active column. A Yes means the layer is turned on. In the final column you can
enter a depth-specific decision criterion.

Click the Add button twice, creating two more rows (or two more layers). We’'ll create three
layers by filling out the entry boxes as follows.

From Ta Palygon Active Remedial Threshold
|EI |1 |Nune ﬂ|‘(es ﬂ|‘3
|1 |2 |Nnne ﬂ|‘(es ﬂ|lj
|2 |5 |Nnne ﬂ|‘(es ﬂ|lj|
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If you have any errors in your design, SADA will highlight these with red boxes when you press
the check button. A common mistake is to have gaps in your layers, as in the following picture.

From Ta Folygon Active Remedial Threshold
|EI |1 |Nnne ﬂ|“r’es ﬂ|[l
1 B e < ves ~lp
B Mone = |[Yes ~lp

Here, we've typed in 0 to 1, 1 to 2, and 3 to 5, leaving a vertical gap between 2 and 3. This is
not allowed. If you want a gap to appear, you'll need to define a layer for 2 to 3 and then turn the
layer off.

You can delete a row by clicking anywhere in the row and pressing the delete button. Make sure
you have the design specified as in the first picture and press OK.

You will see your new design in the list of layer designs. Select MyLayers from the drop-down
list.

Set Verical Layers

‘MyLayers ﬂ Add
Entire Data Layer
Surface Onl %

1-2 (Active with no polygons) v
Interpolate and Place Mew Samples

" At the top @ In the middle

Since we have no data in our SADA file, not much has changed when you selected your new
layer design. One thing that is important to point out is that your depth layer box now has your
layer intervals in them. Note that a layer from 0 to 1 actually means 0<=z<1 (meaning that 1 is
not included in the 0 to 1 layer; it would be included in the next layer 1<=z<2).

=1 ez <]

You can always edit your layers by double clicking in the layer list box.

Double click to edit Delete

0-1 fActive with no polygons) *
1-2 (Active with no polygons) b

This will return you to the layer creation screen we just left.

Finally, when SADA places new samples or interpolates a 3d grid, it will need to know where in
the vertical layer to place the samples. The options are in the center of the layer or the top. This
option is selected in the last part of the Set Vertical Layers section.
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Interpolate and Place Mew Samples

" At the top f |n the middle

The “in the middle” option is the most popular, but sometimes users want an estimated value
exactly at the surface. If the top layer has a nonzero thickness, say 0-1ft, then this would require
you to choose “At the top” in order to have values placed at the top of the layer. Otherwise, they
would be placed at z = 0.5.

Working with Polygons

Within a spatial framework, it is often necessary to select certain items or identify a particular
area in space. SADA allows you to draw various shapes for defining areas and selecting items
in space. These include ellipses, rectangles, and polygons. While it would be more accurate to
refer to these as shape tools, they have been historically referred to as polygon tools and will
therefore remain with this nomenclature. Polygons are very flexible and can be used for defining
irregularly shaped spaces. When a polygon is drawn, items or space located inside the polygon
is either included or excluded, depending on the type of polygon.

Polygons are created and maintained as "GIS-like" layers themselves. In fact, we refer to them
as polygon designs. Each one can be assigned to one or more vertical layers. A polygon layer is
"embedded" into a vertical layer and cuts through the entire layer

Polygons cut through the entire layer.

The part of the parameter window that deals with this is shown here with more detail:
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Polygon designs are stored here by name.

Current Layer Polygons
Layerrange: 0 <= Z< 1))

[MyPolygonDesign ~] Add = Add new polygons here
Use these to (?”;“;'l’;gng's __Delete | <@ Delete polygons here
create/edit = Ejipse <4—= (Create/edit polygons here
polygons " Rectangle

Polygon names (Double click to edit)

Polygon 1

4= Set properties of your
individual polygons here.

<= Sct certain decision rules.

™ Use only selected data during interpolation.

W Show only included polygons

Creating a Polygon Design
Let’s begin by creating a polygon of our own. Press the Add button to add a new polygon layer.

New Polygon Layer E'
Mew Mame |test polygar]
Based On |[Mane) |

Enter the name “test polygon” for the design name. Just like in vertical layers, this polygon
design could be based on an existing design or template. In this example, let’'s choose None for
the Based On option. This means we’ll start from scratch.

Then press OK. If you have more than one vertical layer in your layer design, SADA will ask if
the new polygon should be applied to all layers in the design.

Apply this polygon design to all current wertical lavers?

This is an important question and the answer depends on what you are doing. If you are just
defining the boundary of your site at every depth, you want to say Yes. This turns the polygon
into a "cookie cutter" in both directions, above and below the current layer. The following shows
what a cookie cutter polygon design does:
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If you are interested in bounding something like a contaminant plume, however, you will want to
say NO. You may want a different polygon design for each vertical layer.

Your polygon will now be active in the list of polygons, if selected; however, you won’t see any
polygons on your site until you draw them.

Drawing A Polygon

Notice that there are 3 drawing tools. To draw a polygon, select the appropriate tool.
e Polygon — Allows the user to create a many-sided polygon to partition the data.
o Ellipse — Allows the user to create an ellipse to partition the data.
e Rectangle — Allows the user to create a rectangle to partition the data.

To start drawing, press the Draw button. It will change to Done. Notice that everything becomes
disabled in SADA during polygon creation.
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For the polygon tool, move the mouse over the map and note that the coordinates appear on
the status bar at the bottom of the screen. Each time the left mouse button is clicked, a new
vertex is added. To complete the polygon, double click the left mouse button. For the other two
tools, hold the mouse button down and drag the mouse to create the ellipse or rectangle.

Add as many polygons per layer as desired. To change the layer, select the new layer from the
layer box and add polygons to that layer in the same manner.

When you are finished with drawing, press the Done button. The polygon(s) will now display
over the map and the rest of SADA will become enabled again.

At times, it might be difficult to see your polygon, particularly if you have a photograph behind it.
To see your polygons better, you may want to change their color. From the main menu select
Graphics *Set Various Colors 2Polygons. From the color palette choose yellow and press OK.
The shapes should be easier to see now.
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Polygons may be edited at any time during or after their creation.
Edit Polygons

After a polygon has been drawn, vertices can be removed, added, or moved to another location.
Similarly, an entire polygon can be moved to a new location or deleted entirely. To get started,
press the Draw button again. You can now continue drawing new polygons or edit existing
polygons.

To edit an existing polygon, left-click the mouse to highlight the shape in a blue color. To select
a particular vertex, left click inside the vertex and it will turn red. Notice when a vertex is red, a
new button, the Delete button appears in the Polygon area.

Cument Layer Polygons

Layerrange: D ==2<1)

=

Drawing Tools I
& Polygon

 Ellipse

" Rectangle *h

Flaloimnn womsnn Minobin aliak ba adih

To delete the vertex, press this Delete button.

To move the vertex, hold the left mouse button down inside the vertex, move to the desired
location, and release. To add a new vertex, click anywhere on a line between two vertices.

To select an entire polygon, right click inside any vertex and the entire polygon will turn red. To
delete the polygon, press the Delete button. To move the entire polygon, hold the right mouse
button down inside any vertex, move to the desired location, and release.

When you have a polygon selected (blue vertices are showing), notice that the copy polygon
button is now available on the main toolbar.

L I R

Simply press this button and SADA makes a copy of the polygon. You can now paste this shape
anywhere you like: on the current design or in another polygon design altogether. When a
polygon is available for pasting, the paste polygon button will also become enabled.

2] I R
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Simply press this paste button whenever you are in draw mode and SADA will drop it exactly on
the horizontal position in which it was copied. Note that neither button will be enabled until you
are in draw mode.

The same type of actions work for both rectangle and ellipse as well. The exception is that
obviously you can’t delete vertices, or you would no longer have a rectangle or ellipse.

In the following image, you can see each of the three types of polygons or shapes applied over
a data set. Later we will work with data in depth, but for this discussion, everywhere you see a
circle is where a sampled value was taken for Ac-225. The brighter the color, the higher the
concentration.

Polygons can be either inclusive or exclusive, and a data plot is the best way to demonstrate
this principle. Notice that data found inside each shape is colored and data outside the polygons
is white. The empty circles indicate that they are currently not included. When you draw a
polygon, it is by default an inclusive polygon (meaning that anything inside of it is included). You
can also have exclusive polygons, but to change a polygon from inclusive to exclusive or back
again you’ll need to read on about polygon properties.

Polygon Properties

You have a good deal of control over the individual polygons or shapes you create. To see the
property window for any given shape, just double click the name for that polygon from the list of
polygon names for the given polygon design.
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Polygon names (Double click to edit)

Ellipse 1
Pnlygnn 1 —

Rectangle

Select the polygon collection from the drop-down box on the parameters window and double-
click on the polygon name that appears in the list box below. You may have different shapes
and may wish to use different names. This is OK.

The Polygon Data window will appear.

X

*wx Polygon Data

Mame  |uy Ellipse

v Polygon is turned an

v Polygon is Exclusionary
Comments

Twype your information here,

Ll = IR = T I o R W, TR N IS T S T

Help Ok Cancel

At the top of the window, you can change the name of your shape from its default (e.g.,
Ellipse1) to something more meaningful. In this example, it has been changed to MyEllipse.
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Just below the name is the opportunity to turn this individual polygon off. Keep in mind that if
you turn it off, it will be turned off in any layer for which you are using it. When a polygon is
turned off, it isn’t deleted; it’s just literally turned off for the moment and doesn'’t affect any
analysis.

Below this is the place to set a polygon to be exclusive. If a polygon is exclusive, then anything
inside it is NOT included in the analysis. This is useful in carving out buildings away from the
analysis of outdoor contamination. IMPORTANT: exclusive polygons take precedence over
inclusive polygons. So, if you have a polygon that is inclusive overlapping on one that is
exclusive, any point that is common to both will be UNINCLUDED.

You can also add comments about the polygon in the 10 rows of open text boxes. Click the OK
button to close the window.

Returning now to the parameter window, if the Show only included polygons option is checked,
then SADA will remove all “turned off” polygons from the graphics window. If this option is
unchecked, all turned off polygon names will still appear as a gray outline in the graphics
window. These polygons, however, will not be included in any analyses and only remind users
that they are there.

The option Use only selected data during interpolation is very important. Sometimes, even
though a section of the site, such as polygonal area or layer, has been turned off/exclusionary,
you may not want to interpolate in those areas, but the data from those areas maybe crucial to
the understanding of the spatial process. In most applications, this is the case. For example, if
some of your data were say inside a building and some were outside a building, it may make
sense to not include the inside data to estimate the outside values. In this case, make sure that
this option is selected.

To turn off the polygon collection, simply select None from the main Polygon layer list.
Elevation Grid

At the bottom of the parameters window is an opportunity to select an elevation grid that you
may have imported. If you have one you would like to use, select it now.

Elevation Grid

There will be no apparent change in the interface. But the next time SADA draws a result, it will
include elevation. If you want to see your elevation data, you will need to select it by choosing
Elevation from the data type box and your elevation dataset from the dataset box. Elevation is
only applied to a result following its analysis. In other words, all geospatial models are modeled
as a function of depth below surface. This is advantageous for a number of reasons. Later, the
model is corrected for elevation in the 3d viewer.

Summary

This fairly lengthy chapter showed how to create a SADA file, use GIS layers to set up the site,
create vertical layers, and use polygons to further aggregate our site. The next few chapters will
talk about how to import different kinds of data into your file. You can also use imported data to
help set up your site. We’ll show how to do that as well, briefly revisiting some the principles
discussed here.
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Chapter 5: Importing Sampled Data

There are five types of data that can be imported or created in SADA: sampled data (discrete
sampled values), gridded data (models created outside SADA), elevation data (formulated
outside SADA, digital elevation models, etc.), and two user created types called “standard” and
“probability.” In this chapter, we will concentrate on importing sampled data.

Getting Your Data Ready

Sampled data are the most common form of data users will likely use. These are the usual
sample measurements taken at specific points around your site. Before SADA can import the
data values, it needs the data in a particular format. Fortunately, the format is very easy to work
with; most of the time environmental data comes in this type of configuration. Simply put, data
needs to be in a tabular format with each row representing a single measurement value of a
single contaminant (or attribute). Each column is information about the measurement, such as
the easting coordinate, the northing coordinate, depth, name of the contaminant, measured
value at that location, and so forth. Many times, users look at this data with a spreadsheet
program like Excel. Here is an example data set in Excel.

A | B |lcl] b | E | F|l e [ ] 1 | g | | L
| 1 |Easting  MNorthing Depth Casnumber MName Value Detected Media Date SamplelD Region
2 | 27596.25 21900 0 14265851 Ac-225 2 150 9/26/1870 1 1
312831025 21000 0 14265851 Ac-225 1.6 150 9/26/1870 2 1
4 28935 21900 0 14265851 Ac-225 0.9 150 9/26/1870 3 1
5 | 276855 22200 0 14265851 Ac-225 2 150 9/26/1870 4 1
6B | 2813175 22200 0 14265851 Ac-22% 4.2 150 9/26/1870 5 1
712920275 22500 0 14265851 Ac-225 1.5 150 9/26/1870 5] 1
8 | 271500 23160 0 14265851 Ac-22% 1.7 150 9/26/1870 7 1
9| 27egbs 22020 0 14265851 Ac-224% 36 150 9/26/1870 8 1
10| 280425 23100 0 14265851 Ac-225 4.9 150 9/26/1870 9 1
11 28221 23100 0 14265851 Ac-225 4.2 150 9/26/1870 10 1
12| 2866725 23320 0 14265851 Ac-225 249 150 9/26/1870 i 1
13 2911350 22080 0 14265851 Ac-225 1 150 9/26/1870 12 1
14 27T TS 23580 0 14265851 Ac-225 14 150 9/26/1870 13 1
15| 2TTTATS 23640 0 14265851 Ac-225 249 150 9/26/1870 14 1
16| 28310.25 23400 0 14265851 Ac-22% 3 150 3/22/1993 15 1
| 17 | 28935 23460 0 14265851 Ac-225 0.3 150 3/22/1993 16 1
18 | 23200 22560 0 14265851 Ac-22% 4.8 150 3/22/1993 17 1
19| 28700 22500 0 14265851 Ac-224% 33 150 3/22/1993 18 1
| 20 | 272000 22380 0 14265851 Ac-225 2.03 150 3/22/1893 14 1
| 21| 28984 22787 0 14265851 Ac-22% 26 150 3/22/1993 4 1
| 22 | 27350 22750 0 14265851 Ac-225 25 150 3/22/1883 3 1
| 23 | 27026 22129 0 142685851 Ac-225% 1.7 150 3/22/1883 2 1
| 24 | 27690 23350 0 14265851 Ac-225 26 150 3/22/1993 4 2

25 27500 23270 0 14265851 Ac-225 25 150 3/22/1993 44f 2
| 26 | 28709 22900 0 14265851 Ac-22% 27 150 3/22/1993 43 2
| 27 | 27650 22500 0 14265851 Ac-225 34 150 3/22/1993 33 2
| 28 | 28530 22700 0 14265851 Ac-225 33 150 3/22/1893 i 2
| 29 | 277500 23145 0 14265851 Ac-22% 32 150 3/22/1993 12 2
| 30 27596.25 21900 ] 7440393 Barium 427 150 8/7/1998 13 2
| 312831025 21900 ] 7440393 Barium 351 150 8/7/1996 14 2
| 32 | 28935 21800 0 7440393 Barium 164 150 8/7/1996 15 2
33| 27eghb5 22200 ] 7440393 Barium 435 150 8/7/1998 16 2
| 34 ] 2813175 22200 0 7440393 Barium 87.9 150 8/7/1998 17 2

SADA can import measured values using two different kinds of files. A Comma Separated Value
(.csv) file is the most commonly used file type. Anyone with a copy of Excel or a similar
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spreadsheet program can easily save their file as a .csv file and SADA can read it. Even if you
don’t have a spreadsheet program, you can use simple text editors (e.g., Notepad that comes
with Windows) to create or format your data set. If you are using a .csv file, the first row must be
the title row. Punctuation is not allowed in the column (field) names. The second way to import
measured values is to use a Microsoft Access database. Let’'s examine each of the types of
information now.

Easting and Northing Columns (required)

SADA must have these two columns. They tell where on the site your sample was collected.
SADA does not require or enforce the use of any predefined coordinate system. There are a
number of them available, such as UTMs, state plane, lat/long, and so forth. Many sites have
their own localized system. In some cases, you’ll see sample measurements relative to the
corner of the site or a building. These are all OK. (Note to lat/long users: you’ll need to make
sure you use the negative of your latitude values or your data will plot backwards.)

What is important to note here is that these values must be in the same coordinate system as
any GIS layer you plan on using. For example, the roads.dxf layer seen throughout these
examples is in State Plane Coordinates for Tennessee. You would need to make sure that the
easting and northing coordinates are using the same system or there will be big problems.
Namely, your data will not plot correctly on your GIS layer. Now, if you are not using GIS, then
you have no worries with your coordinate system.

Blank values and non-numeric values are not permitted in either of these columns.
Depth Column (may or may not be required)

If the data are taken over depth, an additional column with the depth value is required. No
empty values are allowed for any of these columns, and non-numerical values are not permitted
for any coordinate or sample value. There are two important things to check about your depth
column. First, make sure your depth is depth below surface and NOT elevation measurements.
SADA operates on the concept of depth below surface. Elevation is used in SADA, but only as a
3d view feature. Second, make sure that your depth values are in the same units as your
horizontal extents. For example, it is nonsensical to use lat/long for horizontal and meters for
depth. Later on, when you do 3d geospatial analysis, this really has bizarre implications. If the
horizontal measurements are in feet, make sure the depth is in feet and so forth. SADA is not
going to do any conversion for you.

Sampled Values (required)

This field is where your measurement value is found. There are no units enforced by SADA
because of the many and varied types of applications for SADA. You will need to make sure that
if you are doing human health or ecological risk assessment in SADA you MUST have your
measured units as follows.

e Soil, Sediment, and Biota: mg/kg for nonradionuclides, pCi/g for radionuclides
o Surface/Groundwater: mg/L for nonradionuclides, pCi/L for radionuclides

The sample values column cannot contain any blanks or non-numeric values. If a measurement
value was a nondetect, you must enter the detection limit into the value column. For example,
you cannot enter for example <5. You would instead enter a value of 5 and then not enter this in
the detection field (see below). Values like NA are obviously not allowed either.
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Name (required)

This column provides the name of the attribute (contaminant) you are measuring in each record.
The field cannot contain any blank values. When you are working with environmental
contaminants, it is common to work with contaminant names that contain commas. These are a
serious problem for comma delimited files, as you might imagine. For example, if you have the
contaminant name 1,2,3-Trichlorobenzene, it would be recognized as 3 separate columns: 1, 2,
and finally 3-Trichlorobenzene. This will cause an error in import. Typically, this error states that
SADA has reached the end of the file unexpectedly. To correct this, make sure your name field
contains the name within quotation marks: “1,2,3-Trichlorobenzene.” Spreadsheet programs like
Excel normally do a good job of taking care of this for you by placing quotations around the
contaminant name. To be sure, however, you may want to open up your .csv file in a simple text
editor, such as Notepad (shipped with Windows), to make sure that you are not running into this
problem. Typically, SADA will complain about reaching the end of the file too soon in this
situation.

It is also important to make sure that each contaminant is consistently named. For example,
make sure you don’t have 1,2,3-Trichlorobenzene also spelled as Trichlorobenzene-1,2,3.
SADA may see these as two different contaminants.

CAS Numbers (not required)

A column containing the CAS numbers can be useful when you are setting up different kinds of
analyses, such as human health. It isn’t required, though. If you do have CAS numbers and
want to use them, make sure that they do not contain any dashes or spaces. This will render
them virtually useless later as SADA tries to match them up to its various data bases. A simple
search and replace in the CAS column using Excel can take care of this pretty quick.

Detection Qualifiers (not required)

Another field of some importance is the detection field. Instead of the normal Us and Js and so
forth, SADA works with either a zero value (sample was below detection limit) or a 1 (sample
was detected). As the user, you must decide whether a value should be considered detected or
not before bringing it into SADA. This involves an area of the environmental process we are not
involved in; however, we do provide some guidance for risk assessment in the tables below if
you have no other instructions.
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R Rejected No
B Blanks Treat as
contaminated non-detect
J Estimated Yes, treat as
detect
uJ Estimated non- | Yes, treat as
detect non-detect
K Biased high Yes, treat as
detect
L Biased low Yes, treat as
detect
U Non-detect Yes, treat as
non-detect

Now for measured values that are considered non-detects, you should enter the detection limit
of the instrument into the column containing measured values. Blank or missing values in the
value column are not permitted.

Date Column (not required)

The date field is not required; but if you do use it, later you can query your data by date to see
how things are evolving over time. This can be useful in monitoring situations. If you do use the
date field you must use some combination of the m, mm, d, dd, yy, yyyy format. Examples
include m/d/yy and mm/dd/yyyy. Dates that include any text (other than /) are not permitted. For
example, September 26", 2004 is not permitted. You would need to use 9/26/2004. In Europe
and other areas that use day/month/year format, this should be ok as long as your data set and
your operating system are consistent.

Media (may be required)

In the event that you plan on doing either a human health or ecological risk assessment, you
MUST have a media column. Proper media identification qualifiers are as follows: Soil — SO,
Sediment — SD, Groundwater — GW, Surface water — SW, Air — AIR, Biota — BIO, and
Background — Background.

Beyond these columns, you can include any other information you like, but the total number of
columns may not exceed 250.

Final Tips

O Now a few general requirements regardless of the type of information follow. First,
you must use quotation marks around items that contain a comma. As mentioned
earlier in the description of the Name column, you might have a contaminant name
like 1,2,3-Trichlorobenzene that would be recognized as 3 separate columns (1, 2, and finally 3-
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Trichlorobenzene). This will cause an error in import. Typically, this error states that SADA has
reached the end of the file unexpectedly. To correct this, make sure your name field is
contained within quotation marks: “1,2,3-Trichlorobenzene.” Spreadsheet programs like Excel
normally do a good job of taking care of this for you by placing quotations around the
contaminant name; however, you may want to open up your .csv file in a simple text editor, such
as Notepad (shipped with Windows), to make sure that you are not running into this problem.

Quotations themselves can be problematic. For example, suppose you had a column that
described where the sample was taken. Suppose for one of the samples this column’s value
says Sample located on "C" Street. Because of the quotation marks around C, SADA sees this
as three separate column values. So it accepts it as: Sample located, C, and finally Street. In
this situation, make sure your field value reads Sample located on C Street. This is not
something a spreadsheet like Excel can anticipate. You will need to make sure that this kind of
thing is cleaned up on your own.

Saving your file as a .csv out of Excel is relatively easy. Open Excel, open your file, select the
sheet you want, and select File ?Save As...The names vary for .csv files, but it is usually easy
to determine the right type to select.

31 Ac-225 2 180 9/26/1970 4 1

31 Ac-225 4.2 150 Qr26/1970 5 1
31 Ac-225

31 Ac-22 R

31 Ac-779 Save in: I2) Data kv @ '_21 ‘Q X Ci j - Toals

31 Ac-229 3 Mame Size | Type
31 Ac-224 ',

31 Ac-225 | MyRete..

31/Ac-22 P
31 Ac-229

31 Ac-229 Desktop
31 Ac-229 .
31 Ac-22 j
31 Ac-229 I+l DEc‘uments
31 Ac-22] .,
31 Ac-221 .
¥
31 Ac-22 e
31 Ac22d Ity Campuiter
31 Ac-229 "
31 Ac-22 o 3 3
31 Ac-2219 My Netwao..,
51 Ac-274 File name: TwoDimensional.csy ~
?1 Ac-229 Save as fype!  |Csv (Comma delimited) (*.csv) ‘v- Cancel
31 Ac-22 Template {*.xlt) ~
43 Barium 427 180 Text (Jah deli(mihed)) (* bt}
: Unicode Text (* ]
33 Barium 351 1350 Microsoft Excel 5.0/95 Wiorkbook (*.xls)
43 Barium 154 150 Microsoft Excel 97- Excel 2003 & 5.0/85 Warkbook (* xls
e —— o . < omma delimited) ) v
I3 Rarinm A7 Q 150 RITIQ0R 17 2

Unfortunately, spreadsheet programs can do odd things when saving to a .csv file. For example,
extra commas may be added and entire extra rows added with nothing in them. It is well worth
your time to open this .csv file in a simple text editor, like Notepad (comes with Windows), and
look at the data yourself for a final check. The following image shows the type of common
problems you may encounter. These are simple fixes that when left uncorrected can cause
great grief during the import process.
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E- TwoDlimensional.csv - Notepad

File Edit Format Yiew Help

27026,22179,0,7440382, Arsenic,23.2,1,50,9/26/1970,23, 2 =
5769023350, 0, 7440382 Arsenic. 321,50, 0/26/1070, 25,2

57500, 23370" 0, 7440382 Arsenic, 30.8.1, 50, 9/26/1970, 3,2

58709 22900 0, 7440382, Arsenic, 32.8. 1,50’ 0/26/1970.1,2

27650, 22500, 0, 7440382, Arsenic, 40,1,50, 9/26/1970,2.1

2853022700, 0. 7440382 | Arsenic. 39.6.1,50,0/26/1970.2,2

57750, 23145, 0,7440382 Arsenic, 38.4.1,50.9726/1970,2 .2

58600, 22400, 0, 7440382, Arsenic. 34. 4.1, 50, 9726/1870.2 .2

26900 22680, 0, 7440382 . Arsenic, 25.2,1,50,0/26/1970,2,2

57506 25,21000,0, 120137, Anthracene. 2.1, 50,0,/26/1970.1,1
58310.75.31900.0. 120127  Anthracena.1.6.1, 50, 9/26/1970.2,1

2893521900, 0,120127, Anthracene, 0.9,1, 50, 9/36/1970, 3, 1

27685 '5,22200.0,120127, Anthracene, 2. 1,50, 9/26/1970. 4. 1

58131 75,22200,0, 120127, Anthracens, 4. 3,1, 50, 9/26/1070, 5,1
29702.75.22500,0, 120127  Anthracene.1.5.1.50.0/26/1970.6.1

37150, 23160, 0,120127, anthracene, 1.7,1, 50, 9/36/1970, 7, 1

27685 5,32930,0,120137, Anthracene, 3.6, 1, 50,3/26/1970. 8,1

98042 5.23100.0, 120127 Anthracens.5.5.1.50.9/26/1070.9.1 Extra Blank Columns
28221,23100,0,120127, ahthracene, 4. 2,159, 9/26/1970,10, 1 it

58667 75,23320,0,120127, Anthracene, 2.9,1,50,9/26/1570.11,1
29113.5,32980,0,120127, Anthracene, 1,1, 50.9/36/1970,12.1 e
27417.74,23580,0,120127, Anthracens, 1.9,1.50, 9/26/1870.13,1,,, , /s,
27774.75,23640,0. 120127 \Anthracene,2.9.1,50. 9/26/1070. 14,1

58310 25,23400.0 120127 Anthracene. 3.1.1, 50, 3/22/1093. 151

58935 23460, 0,120127, anthracene, 0.5,1, 50, 3/32/1993,16.1

38200 22560, 0,120127 anthracene, 4.8,1,50,3/22/1993,17.1

28700 22500, 0, 120127, Anthracene, 3.3.1. 50, 3/22/1993. 181

57200 22380. 0. 120127  Anthracene. 2.1.50, 3/22/1993, 19,1

28984, 227870, 120127 Anthracene, 2. 7.1, 50, 3/22 /1393, 4,1

57350, 25750, 0, 120127 anthracene. 2. 4.1,50, 3/22/1993. 3. 1

27026 22129' 0. 120127 Anthracene.1.2.1.50, 3/22/1993.2 1

57600 23350" 0. 120127 Anthracene.2.6.1.50. 3/22/1093.4.3

27500, 23270, 0, 120127 Anthracene, 2.5.1. 50, 3/22 /1093, 44F, ;2

58700 22000, 0.120127 Anthracene.?.7.1.50, 3/29/1993 43,

27690, 325000, 120127, Anthracene. 3,41’ 30, 3/22/1993. 33.3

2853022700, 0, 120127 Anthracene. 3.6.1.50, 3/22/ . zEXtra Blank Rows
27750,23145,0,120127,Anthr‘acene,3.3

R RN RN ]

Use your text editor to delete or correct any such anomalies and then proceed with import.
Import the Data

We will show this process with a simple example. Begin by opening SADA and creating a SADA
file called MyPointData.sda. This will give us a clean blank slate to work from.

There are two ways to add new sampled values. Choose from the main menu Data »Import
Sampled data. SADA responds with the Open file window. The next step is to use the window to
locate the Microsoft Access or comma-delimited ASCII text file that contains the sample data
and select it by double-clicking the name (or type the name of the file in the file name box).
Navigate to where you’ve installed SADA (probably C:\Program Files\SADA 5.0). Note that the
external file itself is not affected by the conversion process.

After you press Open (we will do this in a moment, just keep reading), if your input file is an
Access database, the following window will appear:
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i Select a Recordset g|
Select a table from C:ASADANS adaTestData.mdb. When you choose a table, SADA will show vou a preview of the table content on the

right.

AGoodThreeD D [ Wame | Casnumber | Easting [Marthing  [Diepth [value
B adD ataet 1 fe-225 14265851  27596.25 21300 0 1.99857
E::ES::SEQ 2 4375 14265651 2831025 21900 0 163026
3 Ae-225 14265851 23935 21900 0 088914
5 cveride 4 he225 14765851 276EE5 22200 0 2053298
ThreeDimersionabw/ithDupli 5 4225 14765851 28131.75 22200 0 4185273
;t‘\:negmrf;gﬁ;gwm“D"Ca‘BSSma” B Ac-225 14265851 29202.75 22500 0 149788
TwaD imanions eiwithDuglcate 7 225 14265851 27150 23160 o 170351
TwoDimersionalw ater B 225 14765851 276EE5 22920 0 2306226
TwoDSoibwithDuplicates 9 4225 14765851 280425 23100 0 4965262
10 Ac-225 14265851 28221 23100 0 4272573
4 »

0K | Cancel | Help |

The pane on the left shows all the available tables in your database. You should select the table
with the needed information and press OK.

The next step in the process, or the first step if your dataset is a .csv file, is to identify the
columns of information in the ASCII data file and match these columns of information to
information categories that are required or may be useful in SADA.

In our current example, select the .csv file TwoDimensional.csv and press Open. You should be
presented with the matching headers window.
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™u Matching Headers with Categories g|

At this point, SADA needs to match fields in your dataset with the
types of information it needs. Some information is required while
others are optional. In the case of depth, you will need to specify a
depth field if your data are in 3d. In the case of risk assessment, you
will need to specify a media field.

Required
e [ams ~]
Walues [value |
Easting |Easting |
Northing Northing |

Optional {but useful)

Depth | Depth

CAS Mumber |Casnumber

Detect Qualifier |Detected

Media Id |Media

Lol Ll Ll o] e

Diate |Date

Ol ‘ Cancel Help ‘

At the top of the window is some useful text to help remind you what’s going on. This step is
actually fairly simple. There are certain fields that SADA requires and others that are sometimes
required or perhaps just helpful in some way. These are divided into the two boxes you see on
this window. The first box holds the required fields. You must have a Name field, a Value field,
an Easting field, and a Northing field. On the right side you see in each drop down list the
names of the fields in your data set. Match the correct field in your data set to what SADA needs
for each piece of required information.

The lower box holds some useful and sometimes required fields (depending on what you want
to do). The same principles apply. On the left are types of information SADA recognizes. On the
right are the corresponding fields. Notice that each of the drop down lists in this group includes
the option "none.” This is because you may not have a field that corresponds to the information
SADA is asking about.
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In particular, the depth category is required only when data exist at varying depths. If the Detect
Qualifier is not assigned, the data are assumed to be all detects. If the media column is not
assigned, SADA adds an artificial media column titled Basic.

WARNING:

If Media ID, which denotes the type of media the contaminants are sampled in (e.g., soil or
groundwater) is not defined, then the human health risk and/or ecological risk modules cannot
be setup later. The media is a critical information category to the risk modules. Also, remember
that SADA expects certain units for measured values in the risk modules.

In addition to these pieces of required and optional information, you can bring in up to 250 fields
of metadata from your record set as part of the import process. Later you can see them in a
variety of ways.

After the columns have been set, press OK. SADA begins the import process. If your data set
contains no errors, you will be presented with a snap shot of the data set (up to 1000 records).
For our current import example, you should get the following screen.

" Data View §|

Mo errors were found invour data set. Here is a snapshot of vour data set (up to 1000
recards)

Easting Morthing Depth Casnumber  MName Value Detected Media Date SamplelD  |Region -
P 275596.25 21800 0 142685851  Ac-225 2 1 S0 97261570 1 1

2831025 21800 0 142685851  Ac-225 16 1 S0 /61970 2 1

28935 21800 0 142685851  Ac-225 09 1 S0 95261970 3 1

276855 22200 0 142685851  Ac-225 2 1 S0 95261970 4 1

28131.75 22200 0 142685851  Ac-225 42 1 S0 95261970 5 1

2520275 22800 0 142685851  Ac-225 15 1 S0 95261970 B 1

27150 23160 0 142685851  Ac-225 17 1 S0 /6180 7 1

276855 225920 0 142685851  Ac-225 36 1 S0 97261970 8 1

280425 23100 0 142685851  Ac-225 49 1 S0 95261970 8 1

28221 23100 0 142685851  Ac-Z25 42 1 S0 9726M1570 10 1

2866725 23220 0 142685851  Ac-Z25 29 1 S0 9r6M157T0 N 1

291135 22980 0 142685851  Ac-Z25 1 1 S0 95261570 12 1

241775 23580 0 142685851  Ac-Z25 18 1 S0 97261570 13 1

277475 23640 0 142685851  Ac-Z25 29 1 S0 9726M1570 14 1

2831025 23400 0 142685851  Ac-Z25 31 1 S0 352271893 15 1

28935 23460 0 142685851  Ac-Z25 0.8 1 S0 352271993 16 1

25200 22860 0 142685851  Ac-Z25 48 1 S0 352211893 17 1

25700 22800 0 142685851  Ac-Z25 33 1 S0 352271993 18 1

27200 22380 0 142685851  Ac-Z25 203 1 S0 352271893 19 1

25984 22787 0 142685851  Ac-Z25 26 1 S0 352211893 4 1

27350 22750 0 142685851  Ac-Z25 25 1 S0 352211893 3 1

27026 22128 0 142685851  Ac-Z25 17 1 S0 352211893 2 1

27890 23350 0 142685851  Ac-Z25 26 1 S0 352211893 4 2

27500 23270 0 142685851  Ac-Z25 25 1 S0 35221993 A4 2

2TNR 4NN n 1 ATREAEA A TR a7 1 =] Ma0 A2 1 hd

OK.

On the other hand, if there were errors in the data set, you will be presented with the data editor
and the complete data set will be presented to you along with any errors highlighted in red. You
will need to correct these errors before proceeding.
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= Ac-225
Cell value is ok,
_El\l_u_ﬂ_hmg ;\.I;_]_epth _i.\/alue ;:I;]_elected - i@_arnplelD _EB_egicm
21900 ] 1 970 1 1
231025 21300 ] 16 1 926970 2 1
| 29935 21900 0 0.3 1 9EAITD 3 1
| preBss 20200 ] 2 1 WIHNITD 4 1
| lmimrs 22200 ] 42 1 9HNIT0 & 1
| Zo027s 22800 ] 15 1 WEATTD B 1
| 2780 23180 0 i 1 9EAITD T 1
| preBss 20900 ] k1 1 WIHNITD @ 1
| lzEn42s 23100 ] 49 1 9261970 9 1
|z 23100 ] 42 1 26570 10 1
| meeTza 23220 0 29 1 9261970 11 1
291135 22980 ] 1 1 12 1
| florar7s 23ma0 i 19 1 572 13 1
| ZrTATE 2640 ] 23 1 26570 14 1
| E3tnzs 23400 0 31 1 3221993 15 1
[ |omoss 23460 ] na 1 3221993 16 1
| 28200 22560 0 48 1 322993 17 1
| zm7oo 22600 ] 33 1 W93 18 1
| zrzoo 22380 0 203 1 32211993 19 1
[ |oBom4 29787 ] 26 1 3221993 4 1
| J27as0 22750 0 25 1 3211993 3 1
| o 22129 ] 17 1 W2M993 2 1
| z7eE0 23350 0 26 1 3221993 4 2
[ o7 23270 ] 25 1 221993 Adf 2
(s 22900 i 27 1 32201993 43 8
{27650 22500 ] 34 1 W99 33 2
| |zesm0 22700 i 33 1 w29 N 2
QK l Cancel l Help l Check all values l Go to next red cell l
|

A detailed explanation of how to correct these kinds of errors in the data editor is provided in
Chapter 9, “Managing Data.” Briefly speaking, the process is simple. The data editor operates
much like a spreadsheet, allowing you to change values in order to meet different data
requirements. Whenever you do not meet a particular data requirement, the particular cell will
appear red. If you hold your cursor over it, the yellow box at the top will tell you what’s wrong.
Now, if you have a lot of red cells, you probably want to Cancel the process and return to your
normal spreadsheet or data management system to correct the errors. This simple spreadsheet
is designed only with the idea that a handful of errors need to be corrected.

Tips: First of all, any errors corrected in this sheet do not change the original
data values in your .csv or .mdb file. Remember that SADA grabs the data all
at once and pulls it into your SADA file, where you can further manage it. It
might be better in the long run to cancel the process and fix the errors in the
source data file.

Second, if you are presented with the data editor and an entire column is red, it is quite likely
that you have mismatched columns. For example, you may have set the Easting column to be
the Name column in your data set. You'll want to cancel in that case and start over. The data
editor will parenthetically tell you in each column what it considers the column to be. So you
wouldn’t want to see something like Names (= Easting). This would mean you assigned the
name to your Easting column.

After the errors have been corrected or the snap shot has been closed, SADA will proceed with
the import. For very large data sets, you may be given the opportunity to "thin" the data some.
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Thinning The Data

As SADA finishes the import process, you may be provided a warning about your site
boundaries. This is common and you can find a discussion of this in Chapter 8, “Importing
Elevation Data.” The same principles apply here and anywhere large data sets are imported into
SADA. For this discussion, we’ll move forward with our smaller data set.

Adjusting Site Boundaries

If you import information into your SADA file that has horizontal spatial extents that are beyond
the current site boundaries, you will be presented with an opportunity to change the site
boundaries to include the current data. This often happens when you have just created a new
SADA file and you are using the dummy site (see Chapter 4, “Setting up a SADA File”).

This is an action that you may or may not wish to take. For example, certain elevation sets
exceed site boundaries, but you do not want to include the entire elevation set. When SADA
sees this situation, you may be presented with the following opportunity:

™. You might need to look at your site boundaries... BJ

Infarmation

Your currently selected data seem to completely fall outside wour
current site boundaries. Ifyouwish. SADA can adjustthe site
boundaries to match the current data set better.

Yisual Example (not necessarily wour exact situation)

Site is down here

Data are up here

[~ Do notwarn me in the future for this data set.

Keep the site boundaries |

Adjustthe site houndaries to the data for me |

You may select either Keep the site boundaries or Adjust the site boundaries to the data for me.
For data sets that you regularly visit but do not wish to be warned about, select the box for Do
not warn me in the future for this data set. If you regret selecting this, you can reverse it by
visiting Tools »Warning Options »Site Boundary Problems>Turn Warnings On. If you choose to
Adjust site boundaries, you are presented with another option.
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™x Snap Options §|
2ADA can snap the boundaries in two ways. First boundaries can
be snapped justto the data setywou are looking at right now.
Alternatively. boundares can be adjusted so that they include all

farms of data, imponted madels, and user defined models that
may existinyour data set. Please choose one.

" Snap boundaries to current data set only.

f+ Snap boundaries to all data sets.

I, Cancel

A

Here, you can choose Snap the boundaries to the current data set only or snap them once-and-
for-all to all data sets found in your SADA file: Snap boundaries to all data sets. This will
automatically update your Site Boundaries information found in your Setup the site step. Further
information on adjusting site boundaries is available in Chapter 4, “Setting up a SADA File.”

When you are presented with this option in our current example, agree to Adjust the site
boundaries and select Snap boundaries to all data sets. SADA should now look similar to the
following image:

™ SADA (CO\Propgram Filen\SADA 6 0\MyPointData sda)
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The first thing you should do is save your file. If you are interested in learning how to import
external models or elevation, please continue to the next chapter. If you would like to jump
ahead and learn how to work with your data, please skip to Chapter 9, “Managing Data.”
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Chapter 6: Import New Data Over Existing Data

The import process can be done again and again on the same SADA file, regardless of the data
type (e.g., sampled, gridded, elevation, etc.). Also, there is no difference whether the file
contains previous data or not. For sampled data, with its richer array of information types,
however, some additional things need to be considered. If your file already contains some
sampled point values and you wish to import more sample data values, you will see a slightly
different import process.

Let’s begin by opening SADA (if it is not already open). Then open the file Twodimensional.sda
from the SADA installation directory. To begin, Save the File as TwoDimensionalWithMore.sda
so we don't affect the original file. This file already has the two dimensional soil data set
imported from twodimensional.csv. We will now import a new set of three-dimensional
groundwater data into the file. In this new data set, there is only one data set of Chlordane
measurements.

Select from the main menu Data 2Import Sampled Data and choose from the file
ThreeDimensional.csv from the SADA installation directory (likely C:\Program Files\SADA 5.0).

SADA will first scan your file and identify the major column headers. The file looks like this in
Excel.

A B c D £ F | &6 | H I J K L [ M [

1 (X b z CAS Mames Values Diatect Midia Dt WELLID pwWelllD SAMP_ D SURELE  SAMPELE
| FIHAED PATEL 8 F8  12EAIE Chlordane 0 DD01E 1 GW WIA994 DP-102-17 DP-102 AFE D 898 a2z
3| 2737389 2336116 5.2 1234123 Chlordane  0.00027 1 GW 3221994 DP-102-120P-102 41311507 398 7
4 | ZIAIBEY 23618 18 1234125 Chlordane 0.00048 1.GW H22N994 DP-102-120P-102 481997 4.8 22
5 | 3T37388 2326116 104 1234123 Chlordane 0 00045 1 GW 32271884 DP-102-14DP-102 AMRMEET a9 6 17
G | 2737389 2326116 13 1234123 Chlordane 000025 1 GW 3221994 DP-102-120DP-102 41311507 398 12
| 2rais e 2306116 126 1234125 Chlordane  0.00012 1.GW H22N994 DP-102-180P-102 481997 4.8 !
8 | 2727388 2 [ 182 1234123 Chlordane  0.00004 1 GW 3221994 DP-102-13DP-102 AMRISET 9.6 2
9 | VBB 23E6118 2005 1234125 Chlordane o 1.GW H22N994 DP-102-180P-102 481997 4.8 -3
10| 2727388 2326116 234 12334123 Chlordane V] 1 GW 32271884 DP-102-150P-102 AMRMEET a9 6 -
11 | 2727389 2326116 26 1234123 Chlordane o 16W 3221994 DP-102-2(DP-102 41311507 398 13
12| 2Ye1291 E3260.99 LH 1234125 Chlordane 04614/ 1.GW H22N994 DP-102-1°0P-103 481997 4.8 32
13| 2751291 23260 93 52 1334123 Chlordane 0 68144 1 GW 32271884 DP-103-170P-103 AMRMEET a9 6 7
14 | ZT512.91 2326099 75 1234123 Chlordane  0.73024 16w 2211994 DP-103-1:0DP-103 4151997 0.8 22
15| 2751291 23260 93 104 1234123 Chlordane 0 38323 1 GW 32271884 DP-103-14DP-103 AMRMEET a9 6 17
16 | 3751291 2326099 13 1234123 Chlordane 012108 1 GW 2211994 DP-103-120DP-103 41311507 398 12
17| 2991291 E3260.99 126 1234125 Chlordane  0.02729 1.GW HZ2N994 DP-102-180P-103 481997 4.8 !
18 | 2751291 23260 93 182 1234123 Chlordane 0 00482 1 GW 32271884 DP-103-130P-103 AMRMEET a9 6 2
19 [ 37512.91 2326099 208 1234123 Chlordane 000076 16W 3221994 DP-103-15DP-103 41311507 308 3
20 | FS1 81 FAEE0 88 234 1234123 Chiordane 000011 1GW 22884 DP-103-18 DP-103 Aangey og B -8
21| 27512.91 2326099 26 1234123 Chiordane 000001 1 GW 32211994 DP-103-2(DP-103 41311507 308 13
22 | ZIS1391 E3260.99 288 1234125 Chlordane o 1.GW H22N994 DP-102-2°DP-103 481997 4.8 -18
23| 2TE1291 23260 93 212 1334123 Chlordane V] 1 GW 32271884 DP-103-2I0P-103 AMRMEET a9 6 =23
24 | 2778253 2326252 2808 1234123 Chlordane 013306 16W 32211994 DP-104-1"DP-104 41311507 0.2 Az
25 | 2ITeLEY 23 2 5405 12341235 Chlordane 020884 1.GW HZ2M994 DP-104-1%0P-104 481997 0.2 27
26 | 2778253 &005 1234123 Chlordane  0.23058 1GW 32271994 DP-104-1:DP-104 41511507 a0.2 22
a7 | 2TeRed 10808 1234143 Chlordane  0.14084 1.GW HZ2M994 DP-104-1£0P-104 481997 0.2 17
28 | 2TTRI 53 2A262 52 13208 1234123 Chlordane 0 (4867 1 GW 32271884 DP-104-15DP-104 AMRMEET 402 12
Aal ATTeT R MRT R A5 N2 AT Chlardana 004737 4N AWAOAA MDD ANA A MDD ANA Ar2 00T an T

The column names in the current SADA file, however, look like the following image (you can get
this result by pressing the information button on the main toolbar):
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*w Information Retrieval

Bla|um <
lEasting MNorthing Depth Casnumber MName Walue Detected Media -
27596.25 21900 0 14265851 Ac-225 2 1 S0
2831025 21900 0 14265851 Ac-225 1.6 1 50
28935 21900 0 14265851 Ac-225 0.4 1 S0
276855 22200 0 14265851 Ac-225 2 1 S0
28131.75 22200 0 14265851 Ac-225 42 1 S0
29202.75% 22500 0 14265851 Ac-225 15 1 S0
27150 23160 0 14265851 Ac-225 1.7 1 50
276855 22920 0 14265851 Ac-225 36 1 S0
280425 23100 0 14265851 Ac-225 49 1 S0
28221 23100 0 14265851 Ac-225 42 1 S0
2BBE7.25 23220 0 14265851 Ac-225 29 1 S0
291135 22980 0 14265851 Ac-225 1 1 50
27417.75 23580 0 14265851 Ac-225 1.9 1 S0
2777475 23640 0 14265851 Ac-225 29 1 S0
28310.25 23400 0 14265851 Ac-225 31 1 S0
28935 23480 0 14265851 Ac-225 0.8 1 S0
28200 22560 0 14265851 Ac-225 48 1 S0
28700 22500 0 14265851 Ac-225 33 1 S0
27200 22380 0 14265851 Ac-225 2.03 1 50
28984 22787 0 14265851 Ac-225 25 1 S0
27350 22750 0 14265851 Ac-228 25 1 S0 -
4 »

So we'll need to do some column matching. You will have to match the columns in the new file
to their counterpart in the current data set. This is done in the Column Matching window.

Column Matching

|Hegi':'” j HEES |[N|:| b atch) ﬂ Accept
ifig- [Mo Matzh) i
ﬁzfttmﬁgﬁr’ WwELLID _ Accept Al
Depth-< SAMP DATE
Casnumber-Cas gEEEEEE
M arne-M ames
Y alue- alues Reset Al
Detected-Detect
kedia-tedia Help
Date-D ate

SamplelD- Mo Match

i} el

Cancel

Match the columns in the current dataset to the columns of the new file using the drop down
arrows. To accept a match, press Accept, and the match will appear in the window below. To
accept all the matches (if you know that the columns are lined up), press Accept All. Select
Unaccept to remove one match or Reset All to return all matches back to their respective lists.

When you are done, make sure your matches look exactly like the following image:
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™ Column Matching

J J matches ta | Ma Matc _J

Easting-»
Marthing-Y
Depth-Z
Casnumber-CAS
MName-Names
Walue-Yalues Reset All
Detected-Detect
Wedia-Media Help
Date-Date
SamplelD- Mo Match
Region- Mo Match

Dane

Cancel

e RELELD

If you did not have a media column in your new data set, SADA would present the following
message:

You did not match wour old media column (Media) ko any new import columns, SA0A can continue but will assign a media tvpe of
BASIC ko all sample values. Would vou like to return o colurmn matching?

Yes Mo Zancel |

Additionally, detect columns have to be matched or SADA will present the following message:

Resolving Detect Columns

'ou did nat match your old detection field [Detected] o a
new import column, Since new data must have a detection
column, pleaze chooze one af the following ophions.

" Return To calumi matching

" Azzume all are detected.

" Azzume all are non-detects.

k. Help

If you specified a date column in your first data set, you MUST specify one in this new dataset.
You cannot proceed unless you do.

After the columns have been set, press Done. SADA begins the conversion process and
presents the data as it will be imported into the Data Editor.

Just like the first time you imported your sampled data, if there are no errors, you will be given a
snapshot of the first 1000 records. If there are errors, you will be presented with the data editor.
In the data editor, you can change a handful of errors (more information is available in Chapter

9, “Managing Data”). If you have too many errors, you should consider correcting them in the
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source file first. Remember that any changes to the data inside SADA will not be made to the
source file on the outside.

Thinning the Data

As SADA finishes the import process, you may be provided a warning about your site
boundaries. This is common and you can find a discussion of this in Chapter 8, “Importing
Elevation Data.” The same principles apply here and anywhere large data sets are imported into
SADA. For this discussion, we’ll move forward with our smaller data set.

Adjusting Site Boundaries

If you import information into your SADA file that has horizontal spatial extents that are beyond
the current site boundaries, you will be presented with an opportunity to change the site
boundaries to include the current data. This often happens when you’ve just created a new
SADA file and you’re using the dummy site (see chapter 4, “Setting up a SADA File”).

This is an action that you may or may not wish to take. For example, certain elevation sets
exceed site boundaries, but you do not want to include the entire elevation set. When SADA
sees this situation, you may be presented with the following opportunity:

" You might need to look at your site boundaries... BJ

Information

Your currently selected data seem to completely fall outside your
current site boundaries. Ifyouwish, SADA can adjustthe site
boundaries to match the current data set better.

Yisual Example (not necessarily your exact situation)

Site is down here

Data are up here

[ Do notwarn me in the future for this data set.

Keep the site boundaries |

Adjustthe site boundaries to the data for me |

You may select either Keep the site boundaries or Adjust the site boundaries to the data for me.
For data sets that you regularly visit but do not wish to be warned about, select the box for Do
not warn me in the future for this data set. If you regret selecting this, you can reverse it by
visiting Tools »Warning Options>Site Boundary Problems >Turn Warnings On. If you choose to
Adjust site boundaries, you are presented with another option.
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*w. Snap Options §|

2ADA can snap the boundaries in two ways. First boundaries can
be snapped justto the data setywou are looking at right now.
Alternatively. boundares can be adjusted so that they include all
farms of data, imponted madels, and user defined models that
may existinyour data set. Please choose one.

" Snap boundaries to current data set only.

f+ Snap boundaries to all data sets.

I, Cancel

A

Here, you can choose Snap the boundaries to the current data set only or snap them once-and-
for-all to all data sets found in your SADA file: Snap boundaries to all data sets. This will
automatically update your Site Boundaries information found in your Setup the site step. Further
information on adjusting site boundaries is available in Chapter 4, “Setting up a SADA File.”

When you are presented with this option in our current example, agree to Adjust the site
boundaries and select Snap boundaries to all data sets.

After submitting data through the Data Editor, SADA adds the new data set to your file. When
SADA returns, you will still be looking at the Ac-225 soil data. To see your new data set, change
the data type from Soil to Groundwater. You should see the following.

" SADA (C\Program Files\SADA 5 0ATwolimensionalWithMore. sda)

Me Graphc: Data Seip Feports Statatcs Export Took e

i & & T/>] L E

You can save your file now. This new data set is a three dimensional data set. If you have not
already done so, please read Chapter 11, “Visualizing and Exploring Your Data.”
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Chapter 7: Importing Modeled or Gridded Data

SADA provides a suite of geospatial modeling and contouring tools that are flexible enough to
handle a wide variety of applications. If you are more comfortable using another contouring
package, however, you can still bring the modeled results into SADA and use them within the
decision and risk frameworks. Also, you may have geophysical or remote sensing data that
have been created/gridded outside of SADA and wish to use them in your SADA file. Import and
use of these results is very easy.

SADA recognizes three types of gridded data formats: SADA grid (*.csv), float grid (*.hdr), and
ASCII grid (*.txt). The float grid and ASCII grid formats are industry standard formats that most
GIS or contouring packages typically export. These are 2d format files, though. SADA also
allows you to import three dimensional models, and different packages have different export
formats. Because SADA permits variable depth layers, we need to use a slightly expanded
format of the typical “grid then results” format. This is the SADA grid format.

SADA grid format

This format permits the type of grids SADA supports, where there can be multiple layers and
each layer can vary in depth. The file must be provided in a comma separated value format
(.csv).

The contents of the file must adhere to certain specifications. The file begins with the definition
of the grid upon which the model was built. So the first two lines define this grid.

X Start, Number Of X, and X Size
Y Start, Number Of Y, and Y Size
The next line must specify the number of vertical layers in the model output.
Number of Z
For the next NumberOfZ lines, the file must contain the beginning and ending z values,
21,22
22,73
Z3,74

where SADA recognizes the layer as inclusive on the lower bound and exclusive on the upper
bound. So, if Z1 = 0 and Z2 = 1, then the layer contains all points Z1<=0<Z2.

The next line contains the missing value parameter. If there are any points in the model that
were not calculated for some reason, enter the value you are using to represent these missing
values here.

From this point forward, the model values are provided one per line, cycling fastest on x, then y,
and finally by layer. So, the first value would be the cell result on the first column, first row, on
the first layer. The second value would be the cell result on the second column, first row, first
layer, and so forth.

The following image shows an example two dimensional model in a SADA grid format:
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E7026,50,43.535
21900,50,34.4
1
0,0
~1E+20
1.7957316
.8113263
8269213
.8425187
8581175
8737165
.8893151
.9049128
.920509
.9361034
951696
L96TZB6T
.9828755
.9984629

a7oAaoncg

e e e e e T e e el e e

Float Grid (*.hdr/*.flt)

This is an industry standard grid supported by most major GIS systems, such as ESRI Arcmap.
See the ESRI documentation for converting any raster set in ArcMap into a Float Grid. You will
need to provide both the *.hdr file and the * flt file in the same directory when importing into
SADA.

ASCII Grid (*.txt)

This is a standard grid format for storing raster data and is supported by most major GIS
systems, including ESRI ArcMap.

Importing the Gridded Data

If you have SADA open, please open the file Twodimensional.sda (File 2Open and navigate to
where SADA is installed). Regardless of the type of gridded data you have, select from the main
menu DataImport Gridded Data, and SADA responds with a standard open window. For this
example, we will import the file FieldDetectionResults.csv. This file is a two dimensional model
of a gamma walk over survey.
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Open @'g
Lookin: |3 SADASO ~| *=EcBEr
LY CaecosLpport
( z) CIRiskModels
. HFeldDetectionResuits.csv
My Recent

Documents

€
Deskiop

WMy Documents

.g File name:

My Network Files of type:

|SADA Standard Grid Formet (* csv)
SADA Standard Grid Format (*.csv/
Float Grid (*hdr)

ASCH Grid Formati* td)

To pick the type of gridded map you wish to import, click on Files of type and select accordingly.
In this case, we will choose SADA Standard Grid Format. Select the file named
FieldDetectionResults.csv and press Open.

SADA responds by asking for a name to give to the model result.

=% New information :”E|g|

Fleaze enter a name for the new
information wou are aboutto add.

|Mylmpurtedhf1|:|de||

Ok Cancel |

A
Press OK and SADA will import the model and add it to your list of data sets.

Thinning The Data

For very dense models, you may be given the opportunity to "thin" the model some. This is
normal, and a discussion is found in Chapter 8, “Importing Elevation Data.” In addition, as SADA
finishes the import process, you may be provided a warning about your site boundaries.
Adjusting Site Boundaries

If you import information into your SADA file that has horizontal spatial extents that are beyond

the current site boundaries, you will be presented with an opportunity to change the site
boundaries to include the current data. This often happens when you've just created a new

79



Introduction to Spatial Analysis and Decision Assistance

SADA file and you’re using the dummy site (see Chapter 4, “Setting Up a SADA File”). In this
case, you will not see this option, as the site is horizontally configured to include our field
detection results model.

In general though, this is an action that you may or may not wish to take. For example, certain
elevation sets exceed site boundaries, but you do not want to include the entire elevation set.
When SADA sees this situation, you may be presented with the following opportunity:

™. You might need to look at your site boundaries...

Infarmation

Your currently selected data seem to completely fall outside wour
current site boundaries. Ifyouwish. SADA can adjustthe site
boundaries to match the current data set better.

Yisual Example (not necessarily wour exact situation)

Site is down here

Data are up here

[~ Do notwarn me in the future for this data set.

Keep the site boundaries |

Adjustthe site houndaries to the data for me |

You may either keep the site boundaries or adjust them. For data sets that you regularly visit but
do not wish to be warned about, select the “Do not warn me in the future for this data set”
option. If you regret selecting this you can reverse it by visiting Tools »Warning Options »>Site
Boundary Problems >Turn Warnings On. If you choose to adjust the site boundaries, you are
presented with snap option.
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*w. Snap Options ﬁ|

2ADA can snap the boundaries in two ways. First boundaries can
be snapped justto the data setywou are looking at right now.

Alternatively. boundares can be adjusted so that they include all
farms of data, imponted madels, and user defined models that
may existinyour data set. Please choose one.

" Snap boundaries to current data set only.

f+ Snap boundaries to all data sets.

I, Cancel

A

Here, you can choose Snap the boundaries to the current data set only or snap them once-and-
for-all to all data sets found in your SADA file: Snap boundaries to all data sets. This will
automatically update your Site Boundaries information found in your Setup the site step. Further
information on adjusting site boundaries is available in Chapter 4, “Setting up a SADA File.”

The result of your import can be seen by selecting Imported Model from the list of data types
and selecting your recently added model from the list of data sets.

If you now look at your list of interviews, notice how many geospatial tools are available
(determine areas of concern, sampling designs, and cost benefit analyses). You will notice

some new features (simple map arithmetic) as well.

These tools will behave just as if you had created this model using one of SADA’s contouring
packages. To learn more about these, visit the applicable chapters.
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|View my model

Yiew my model

kodel spatial carrelation
Draw an area of concern map
|Calculate costvs cleanup
Dewvelop sample design
Simple map arithmetic

T T T Ty L

You may now close your file. When asked to save, say No.
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Chapter 8: Importing Elevation Data

SADA permits users to bring elevation data into their analysis. The same types of grid file
formats for importing gridded data discussed in the previous chapter apply to elevation grid
data. SADA allows users to import Digital Elevation Models or DEMS. Note: Regardless of the
type, be advised that SADA DOES NOT perform any type of projection or coordinate
conversions. The user is responsible for making sure the elevation information and any sampled
or modeled values applied are reconciled before bringing them into SADA.

It may be that you don’t have access to local elevation information and may want to construct
your elevation contours from elevation point measurements taken across your site. If this is the
case, simply import the elevation data through the standard sampled or point data format (see
Chapter 5, “Importing Sampled Data”). You can then contour the elevation measurements and
store the model. If you do have elevation information from outside SADA, the following formats
are permissible.

Standard SADA Grid, Float Grid, and ASCII Grid

Just like in the import model case, SADA recognizes three types of gridded data formats for
elevation: SADA grid (*.csv), float grid (*.hdr), and ASCII grid (*.txt). The float grid and ASCII
grid formats are industry standard formats that most GIS or contouring packages typically
export. You can also bring in elevation in a SADA file format, but this isn’t really necessary since
that format is usually associated with 3d data.

Digital Elevation Model (DEMS)

A digital elevation model (DEM) is a standard GIS format for storing often very dense elevation
data. The USGS provides a great deal of elevation data as DEMS, typically very dense and
often in UTMs. Note: SADA does not convert UTMS and unless your data set is in UTMs or you
have made the conversion outside of SADA, you should not use DEMS.

Importing Elevation Data

We’'ll use a quick example to show how to import some elevation data into SADA. First, open
SADA and open the SADA file MyEmptyFile.sda. This is an empty file, so SADA will ask us
questions about adjusting site boundaries and so forth when we bring in the elevation data.

From the main menu, select Data>Import Elevation Data. SADA presents the standard open
windows form. As in the case of importing gridded data, click on the File of type to choose the
type of file you wish to import.
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Look in: | 3 SADASD Ll

By ecosupport

( 4} CIRiskModlels
Hknob_cresk.dem

My Recent
Documents

)

Deskiop

My Documents
My Computer

File name:

Iy Network: Files of type: ]Digitul Elewation Model(* dem)

Cancel

SADA Standard Grid Format [* csv)
Float Grid (* hdr)

* ASCH Grd Format™ t
Digital Elevation Model(* dem)

Next, select the file knob_creek.dem and press Open. This is elevation data in the East
Tennessee area. In the next window, provide the name you wish to call your elevation set. In

this case call it “MyElevation.” Press OK.

®=. New information |:||E|g|

Fleasze enter a hame forthe new
information you are aboutto add.

|MyEIevati or|

K.

Cancel |

A

Thinning The Data

If your information set has a very large number of data, it may be practical and even desirable to
thin the data set some so that it does not consume an inordinate amount of resources. This is
likely to be the case when importing geophysical data, elevation data, and so forth. If this is the

case, SADA will present you with a window for selecting a subset of the data.
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®w, Information Sampling Rate B|

This file has owver 100000 points of information. Choose a
sampling rate for your data from below to see how it reduces the
information load.

Selectevery |FT w | row and calumn.

1648224 blocks now becomes 25666 blocks.

Ok, ‘ Cancel ‘

Z

Thinning is done geometrically by selecting every other value, every fourth value, and so forth.
By changing the sampling rate, you can see the impact on the number of samples or grid cells.
Select 8" from the drop-down list and press OK.

Adjusting Site Boundaries

As you know from reading previous chapters, if you import information into your SADA file that
has horizontal spatial extents that are beyond the current site boundaries, you will be presented
with an opportunity to change the site boundaries to include the current data. This is an action
that you may or may not wish to take. For example, certain elevation sets exceed site
boundaries, but you do not want to include the entire elevation set. When SADA sees this
situation, you may be presented with the following opportunity:
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s You might need to look at your site boundaries...

Information

Your currently selected data seem to completely fall outside your
current site boundaries. Ifyouwish, SADA can adjustthe site
boundaries to match the current data set better.

Yisual Example (not necessarily your exact situation)

Site is down here \

Data are up here

[ Do notwarn me in the future for this data set.

F.eep the site houndaries

Adjustthe site boundaries to the data for me

You may either keep the site boundaries or adjust them. Note: For data sets that you regularly
visit but do not wish to be warned about, select the “Do not warn me in the future for this data

set” option. If you regret selecting this, you can reverse it by visiting Tools »Warning Options >
Site Boundary Problems >Turn Warnings On.

If you choose to adjust the site boundaries, you are presented with another option. For this
example, choose Adjust the site boundaries to the data for me.
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*w. Snap Options §|

2ADA can snap the boundaries in two ways. First boundaries can
be snapped justto the data setywou are looking at right now.

Alternatively. boundares can be adjusted so that they include all
farms of data, imponted madels, and user defined models that
may existinyour data set. Please choose one.

" Snap boundaries to current data set only.

f+ Snap boundaries to all data sets.

I, Cancel

A

Here, you can choose to Snap boundaries to current data set only or Snap boundaries to all
data sets (once-and-for-all to all data sets found in your SADA file). This will automatically
update your Site Boundaries information found in your Setup the site step. Choose to Snap
boundary to all data sets. (We only have one — MyElevation, so selecting either option here is

really the same thing.)
You are finally presented with the results of your elevation map.

Elevation Data
3985 935.00 142.10
3,984,103.00 127.74
o 398127100 11338
£
=
t
o
4
3,978,439.00 I
Loo 02
3,975 B07.00
B4 56
3972.775.00
6301500 285343.00 26767100 26999300 27232700 Z74ESA0 70.30
Easting
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Using Elevation Data in Your Work

Elevation in SADA is used primarily in the 3d viewer. There is a chapter on using the 3d viewer
(Chapter 44) that you may want to look at later in your readings. Essentially, this 3d viewer will
use elevation to properly position data points and model cell values in correct relation to each
other vertically, so that land contours are represented in the final outcome.

Note: SADA’s basis is always “depth below surface.” This is how vertical layers are defined and
how geospatial modeling is done. Using depth below surface to produce, for example,
geospatial models can be advantageous over using elevation. Consider the following scenario.
We have a shallow valley with a subsurface geology that is in a typical pancake formation.

-

N

Cross sectional view from
true 3d perspecitve.

From a geospatial perspective, this would be a difficult way to assess correlation structures,
particularly anisotropic conditions. In order to assess the spatial structure, it would need to be
broken into subsections in which the lower part of the valley sees fairly horizontal correlation
structures, the left side of the valley sees correlation structure on a downward angle, and the
right side of the valley sees structures on an upward angle.

Instead, if you view the modeling from depth below surface, you can see that really you have
fairly consistent layers when measured by the depth, so that a single correlation structure (and
geospatial model) may suffice to model the entire domain. So, you first model the domain and
then correct in the visualization for elevation.

A situation where we will need a little more attention is seen in the following schematic:

Here, we have a ditch, canyon, or perhaps an excavation situation. In this scenario, you can still
attack it with the depth below surface approach. You'll just need to use your polygon tools to
exclude the center portion.
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To turn the elevation on in your 3d viewer, you need to visit the step Setup the site. In the lower
portion of the parameter window, you'll see a drop-down list of your elevation models. You
would select MyElevationModel in this case. No change will be apparent until you actually use
the 3d viewer (see Chapter 44).

Generating Elevation Coverage From Scratch

In many cases, users don’t have access to elevation data or don’t know how to properly project
it before bringing it into SADA. This is actually an advanced GIS operation; however, users may
have quite a bit of elevation data stored in their measured samples data set. Sometimes the
elevation is recorded with each sample. Users could extract this information into a separate data
set using Excel. In this separate data set, the information would be created with the following
fields: Easting, Northing, Depth, Elevation Value, and Name.

Depth is meaningless but should be added to the data set with a value of zero in each record.
Name is meaningless but should be added with a value of "elevation” for each record. Both of
these fields are included only because SADA requires them in the next step. Now one can
import this into SADA as a point file. Once the elevation data is in SADA as a set of point
values, use a fine grid and natural neighbor interpolation to contour the elevation values. If the
sampling is representative enough of elevation changes, the result may be adequate. Once this
is created, export the model as elevation.csv. SADA will automatically export the results as a
standard SADA grid. You can now bring this file back in using the SADA Grid format method
described above to create an elevation data set for yourself.

. Setup the site z|
Site Boundary

Minimum Ma:umum
. - o D
Easting  |HEENE [rages
Morthing 3‘3?2??5 3956935 Q

Snap

Set Vertical Layers
[ ] Agd

Layers (Double click to edit) — —

iy

Interpolate and Place New Samples
T At the top @ In the middle

Current Layer Polygons
Layer range: (Z=10.)

[(None) -] Al |
Drawing Tools
@ Polygon |
" Ellipse /
" Rectangle [_/
Palygon names (Double click to edit) — )
| o
™ Use only selected data during
¥ Show only included polygons
™ Update map when you draw shapes (slowar)
Elevation Gnd Help
|M5"E|9°’11i0n __—

You can now close your file and save it if you like.
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Chapter 9: Managing your Data Sets

Often, users will have a SADA file with many, many data sets (e.g., contaminants), some of
which may no longer be of much use. For example, in a risk assessment, they be identified as
not contributing to risk and may be excluded from further analysis. There may be many other
reasons why you may want to exclude or delete a data set. In addition, you can edit your data
values after they’ve been brought into SADA. You'll use the data editor to do this. Just
remember that any changes made to your data inside of SADA will not affect the source data
file used in the import process.

Hiding Data Sets

There are two ways to exclude a data set from your file. The first method is to just hide a
particular data set using the contaminant manager. This is a hon-permanent way to remove
data in order maintain an uncluttered environment.

Open Twodimensional.sda. Save the file as TwoDimensional Managed.sda to make sure you
don’t alter the original file, as it is used in other examples. From the main menu, select Data>
Data Set Management->Choose Included Data Sets.

SADA presents the data set manager.

|Sail ~|

Data Set Is Available Data Set Is Hidden

Ac-225
Anthracene
Arsenic
Barium

F
Lt

ok | Help |

In the upper-left-hand corner, select the data type of interest. The rest of the window displays
the data sets that are available (visible) on the left side and data sets that are hidden on the
right. Move data sets using the arrows to the appropriate side. When you are done, press the
OK button. You will no longer see your hidden contaminants anywhere in the interface. They are
not deleted though, and you can restore them at any time.
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Deleting Data Sets

The second way to exclude data is to permanently delete the contaminant. Again, select from
the main menu Data»Data Set Management->Delete Data Sets.

®™x Delete Data Sets E|

|Soil |

Ac-22h
Anthracens
Arsenic
Barium

Delete

This brings up the Delete Data Setst window. At the top of the window are the available data
types. Select the one you are interested in (e.g., in the figure above, we have Soil data
selected).

SADA fills the lower box with the data sets found in that data type group. So, in the figure
above, we have all the soil measurements. Place a check mark in the box next to the
contaminant you want to delete. Press the Delete button. SADA will ask for confirmation. If you
confirm the delete, the data set is permanently removed from the file.

Note: Keep in mind that these changes are not permanent until you save the SADA file.
Using The Data Editor
A very simple data editor is provided to allow minor changes to a point or measured value data

set. If you have a large data set with a large number of errors (for example, during import), you
should seriously consider fixing it outside of SADA as the editor is limited in features.
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The data editor is presented to you in two locations. First, if there are errors when you import
point data values, you will be presented with the data editor and an opportunity to correct the
errors at that time.

To manually open the data editor, select from the main menu Data>Data Management>Edit
Sampled Data Table...

Open Twodimensional.sda. Select from the menu Data»>Data Management->Edit Sampled Data
Table.... SADA presents you with the Data Editor.

“w Ac-225

Cell value is ok,

Easting iNonhing iDepth I\fa\ue iDetected iDate |SamplelD iRegion

27596.25 21900 i} 2 1 9261970 1 1
2631025 21900 0 16 1 9261970 2 1
s om0 Bs L 1
- 27BEA.S 22200 0 2 1 9261970 4 1
TS 22200 i} 42 1 9261970 5 1
2920275 22500 0 125 1 QBNFFD B 1
27s0 23160 i} 14E 1 9261970 7 1
. 27BEA.S 22920 0 36 1 9261970 8 1
 2m0425 23100 i} 49 1 9261970 9 1
e 23100 0 42 1 926A15970 10 1
|26667.25 23220 i} 29 1 9261970 1 1
2e1135 22980 0 1 1 9261970 12 1
2T TS 23580 i} 19 1 9261970 13 1
27EATS 23640 0 29 1 261970 14 1
2631025 23400 i} 31 1 3221993 18 1
28935 23460 0 0.8 1 322/1993 1B 1
 2a200 22560 i} 48 1 3221993 17 1
- 2Er0 22500 0 33 1 3/22/1993 18 1
 27m 22380 i} 203 1 32211993 18 1
26084 22787 0 26 1 3221993 4 1
270 22750 i} 25 1 3221993 3 1
2702 22129 0 T 1 3/22/1993 2 1
270 23350 i} 2b 1 3221993 4 2
27Em0 23270 0 25 1 322/1993  44f 2
20709 22900 i} 27 1 32211993 43 2
- 27Bs0 22500 0 3.4 1 342211993 33 2
:28530 22700 i} 33 1 3221993 1 2

QK | Cancel | Help l Check all values | Go to nesxt red cell |
|

The top of the window displays the name of your data set. Here, it's the Ac-225 soil data.
Underneath this, there is a yellow box. This yellow box will report errors you may have in your
data set.

Below the yellow box is the grid itself. To edit any value, simply place your mouse in the cell and
click. Enter the value you like and then click in another cell to continue.

If you type a value that is invalid, SADA will turn the cell red. When you place your mouse over
the red cell, the yellow box reports the problem with the value.
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"w Ac-225

Error in cell: Walue is not numeric
Easting Northing Depth Value Detected Region
2759625 21900 o 2 1 £l I 1
28310.25 21900 1] 16 1 2 1
128935 21900 ] 09 1 3 1
27685.5 22200 1] 2 1 4 1
:28|31 75 22200 1] 42 1 ] 1
29202.75 22500 1] 15 ] 1
27150 23160 1] 7 1

| flmesss 22920 0 5] 1 97261970 8 1
28042.5 23100 1] 49 1 97261970 9 1
:28221 23100 0 42 1 9/26M970 10 1
28667 .25 23220 1] 29 1 97261970 N 1
:29|13.5 22980 0 1 1 9261970 12 1
27775 23580 1] 1.9 1 97261970 13 1
2777475 23640 1] 29 1 97261970 14 1
28310.25 23400 1] 31 1 322M993 15 1
28935 23460 0 0.8 1 3221993 16 1
28200 22560 ] 48 1 3221993 17 1
26700 22500 0 33 1 3221993 18 1
:2?203 22380 1] 203 1 3221993 19 1
26984 22787 0 26 1 3221993 4 1
:2?350 22750 0 25 1 3221993 3 1
27026 22129 0 1.7 1 221993 2 1
27690 23350 0 26 1 3221993 4 2
27500 23270 1] 25 1 3221993 A4 2
268709 22900 0 27 1 3221993 43 2
27650 22500 1] 34 1 3221993 33 2
28530 22700 0 33 1 3221933 1 2

Ok | Cancel | Help | Check all values | Go to next red cell |
Z |

In the image above, we've entered the text "wrong" into the value column. This column requires
only numeric values. Placing the mouse over this cell updates the yellow box to report that the
value is not numeric. To correct any errors, visit each red cell and enter a valid entry. If you
have a number of errors scattered throughout your data set, you can use the Go to next red cell
button at the bottom right of screen to navigate to the next row that contains a red cell.

You can delete a row of data by selecting the row selection field on the far left. A black arrow
will appear in the row you selected. Press the Delete key on the keyboard.

28221 23100 0 42 1 Y270 10 1
»DBBE7 25 123220 0 29 1 926970 11 1
291135 22980 0 1 1 Y/ 12 1
2741775 23580 0 19 1 Y/ 13 1
2777475 23640 0 29 1 YN0 14 1

| 2831025 23400 0 3.1 1 32211993 15 1

You can add new data by visiting the bottom of the grid. You will find the last row has an
asterisk in the row selection field.

| Help | Check all values | Go to next red cell ‘

Simply start typing in this row to add a record.
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Show Only Registered Contaminants

In SADA, you have an opportunity to set up different analyses, such as human health,
ecological risk, and custom analysis, through the Setup Menu. For measured point values, you
are required to register each data set (e.g., contaminant) as part of the setup. The chapters on
risk and custom analysis will take you through this process, so don’t worry if you are not yet
familiar with this process. For users that are familiar, sometimes not all of your data sets (e.g.,
contaminants) will be registered because you don’t want to register them or because they have
no counterpart in the setup you are running.

For example, when a human health setup is complete, you can switch to human health using
the analysis box. SADA responds by placing as a default only those data sets in the data set
box that were registered during the setup. This is designed to simplify your experience and de-
clutter the interface with data sets that are not currently relevant. If you would like to see all the
data sets (e.g., contaminants), whether they were registered or not, simply select, from the main
menu, Data>Data Set Management>Show Only Registered Contaminants.

This menu item is actually a toggle switch. If it is checked, then you will see only registered data
sets for the current analysis. If it is not checked, you will see all available data sets. You may
now close your SADA file.
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Chapter 10: Automatically Importing Information into SADA from Your Database
Management System

Your institution may have a centralized or official database management infrastructure in place.
From this system, you query and export data sets so you can manipulate them in a manner that
they can be imported into SADA. This chapter talks about different options for sending
information to SADA behind the scenes in an automated way, so that the transition from your
database system to SADA can appear seamless. Similarly, this automation can allow SADA to
be called and controlled by any external modeling or management system so that it can be laid
in-line with the institution’s modeling toolbox. This chapter is really targeted at the IT folks in
your institution more than the end SADA user. If you are not an IT person, then what is really
important is that you know this capability exists.

Writing Automation Script

The lion’s share of this task is really on your in-house programmers or information technology
folks. What they will need to do is write a small script or code that exports the information out of
the main system into a .csv file automatically. Typically, this is not difficult to accomplish, as the
requirements bar for data format is fairly low. Upon successfully exporting the information to a
.csv file, this same script or code will execute the SADA application using a “shell” type
command or equivalently with a command line prompt. They will then need to provide some
additional command line arguments that tell SADA exactly what file was just created and what
to do with it. If you are not familiar with this type of language, it's OK; your IT folks will likely be
familiar with it. This sounds hard, but it's really quite trivial.

Command Line Prompts
When SADA opens, it looks for a command line prompt. If there is one, the first thing it does is

look at the last four characters of the prompt. These four characters tell it what to do next. They
are:
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Command Line Meaning Example
Argument
".sda" Means open the SADA file | have sent | Sada5.exe MySADAFile.sda
you.
" efo" Create an empty file with the name SADAS5.exe MyEmptyFile.sda
I've given you and then open SADA efo
up showing this file.
"efc" Create an empty file with the name SADAS5.exe MyEmptyFile.sda
I've given you but don’t open SADA efc
up (completely silent).
" dfo" Create a file with the data I'm sending SADAS.exe
you as defined by the .sdx file. Then, MyDataTolmport.sdx dfo
open it up in SADA.
" dfe" Create a file with the data I'm sending SADAS5.exe
you as defined by the .sdx file. Then, MyDataTolmport.sdx dfe
don’t open SADA (completely silent).

Now, the sdx file has the following formats.
SDX File Format

Line: Parameter Description

1:  The new sada file name with full path

2: The source data file (*.csv) with full path

3: Data Type (Elevation model = 11, Standard Model = 10, Sample values=6)

4: Data Subtype (Elevation model = 11, Standard Model = 10, Sample values=6)
If Data Type = 11 or 10 then

5. Name to give the model you are importing

6: Sampling Rate Power for reading in the model (for example 2*0 1 = every value,
27M = 2 = every other sample, 22 = 4 every fourth sample and so on where N is the
sampling rate power)

If Data type = 6 (sample values)

5: Sampling Rate Power for reading in the model (for example 2*0 1 = every value,
27M = 2 = every other sample, 22 = 4 every fourth sample and so on where N is the
sampling rate power)

Beginning with line 6 and 7, you must enter the name of the primary field SADA is looking for,
then a comma, and then the column number where it is located in your data set. The field
numbers are 1 based. That is, the first column is column =1, the second column is column = 2,
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and so forth. The recognized field names are: Easting, Northing, Depth, CAS, Name, Value,
Detect, Media, Date.

Your fields can be named anything you like; these are just string based identifiers to tell SADA
where the needed information is. For example, Easting = 1 means that the easting coordinates
are in the first column

Automation Examples

Here is an example of a SDX file to directly import the threedimensional.csv file packed with
SADA. You can use this file to create the file MyThreeDimensional.sda automatically. Note: your
directory structure may vary. In this example, every required field or field of interest that SADA
might use is included and is coincidentally in order.

C:\Program Files\SADA 5.0\MyThreeDimensional.sda
C:\Program Files\SADA 5.0\ThreeDimensional.csv
0
6
0
Easting, 1
Northing, 2
Depth, 3
CAS, 4
Name, 5
Value, 6
Detect, 7
Media, 8
Date, 9
Here is an example of an SDX file where only a few of the base required columns are present.
C:\Program Files\SADA 5.0\MyTwoDimensional.sda
C:\Program Files\SADA 5.0\TwoDimensional.csv
0
6
0
Easting, 1
Northing, 2
Name, 5
Value, 6

This example will automatically import the elevation model “knob_creek.dem” packed with
SADA, and it will sample every 16th (2*4) value (it's a huge file).
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C:\Program Files\SADA 5.0\TwoDimensionalElevation.sda
C:\Program Files\SADA 5.0\knob_creek.dem

1

11

MyElevation

4
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Chapter 11: Visualizing and Exploring Your Data

Once you have imported your data set into SADA, you will likely want to start by exploring your
data. SADA provides ways visualize your data, query some information, and perhaps look at
some basic statistical results. This chapter highlights some of the most important tools for
spatially examining your data. Let’s begin by opening a SADA file that has already been
populated with some data. Open SADA and select from the main menu File 2Open. Navigate to
the directory where SADA has been installed (probably C:\Program Files\SADA 5.0) and select
AThreeDimensionalStart.sda. After the file opens, save it as MyThreeDimensionalStart.sda
using the main menu File ?Save As...

This file is in a very early stage of development. After creating the file, the Chlordane
groundwater data from ThreeDimensional.csv was imported. Beyond that, nothing has been
done. We'll begin first by looking at the 2d Graphics window.

Understanding the 2d Viewer Graphics Window

With the file MyThreeDimensionalStart.sda open (see above), we’ll begin with discussing what
we are looking at in the graphics window. First of all, SADA defaults to the “2d” graphics
window. This is the normal graphical view that most users use. SADA also has a 3d viewer
window and we’ll see how that works very soon. At the moment, the SADA interface looks like
this.

Indicates we are Means we are looking a the Means we are looking at all
looking at groundwater Chlordane GW dataset. the data between 0 and
data now. 51.22 feet.

% SADA (C:\Program Files\SADA & TWMyThreeDimensionalStart.sda) |'._|E|

tasults

The hashed circles around the sample |zs=e -
points mean that within this current
layer, data are found under this point
and may not visible at the moment.

B2 B 000

First of all, you can tell from the data type box that we are looking at groundwater data. If you
select the arrow next to Groundwater, you'll see that this is the only type of data we have at the
moment. You can also tell that we are looking at Chlordane data. In the data set box, you'll see
the name Chlordane. Selecting the drop-down arrow on this box shows only Pooled data and
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None. Pooled data is not a data set per se and is something we’ll talk about in an upcoming
example. In the far right drop-down box, SADA indicates that we are looking at a very thick layer
from 0 to 51.2+ feet. So, if you look in the graphics window, you’ll see a spatial plot of the
sample values that occupy a vertical depth of 0 to 51.2+ feet. Notice that virtually all the
samples are encircled by a hashed circle. Anytime you see a point value drawn like this, it
means that within the current layer there are samples located below this point (but still within the
selected layer) that you cannot see. The term “within the current layer” is important to note here.
These hashed circles are only drawn when data within the same layer overlap each other. If you
don’t see the circles, it doesn’t mean there is no data at all anywhere below this point (within the
selected layer). In fact there may be points at lower or higher layers, but they would be seen
only when those layers are selected. Note: For review please see the section in Chapter 4 on
setting up vertical layers.

The circles are filled according to the legend on the far right. Notice that the higher the
measured value, the brighter the color. Shortly, you'll see how to make your own legends.

Try moving your mouse over the graphics window and notice that in the lower left hand corner
of your screen SADA is reporting the current coordinate of your mouse pointer. This can be very
helpful in your data exploration.

Coming up with reasonable vertical layers

Let’s return to the thick layer we’re currently using. It turns out that the very thick layer
(0<=z<51.2148) is the layer design Entire Data Layer. This is a special layering design
presented in Chapter 4, “Setting up a SADA File.” This layer design is dynamically controlled by
SADA to always be large enough to show all the data at once. This is helpful when you first
bring a data set in and want to make sure all your sampling stations were properly imported. To
find out what layering design you are currently using, click on the step Setup the site. Recall that
here is where vertical layering designs are managed. In the center of the parameter window
you'’ll notice that Entire Data Layer has been selected.

et Vertical Layers

Layer design cannot be edited. |

Suppose now we want to come up with our own vertical layering scheme that allows us to see
the data in thinner layer divisions. There are different motivations for choosing a layering
scheme. You may want to use layer thicknesses that correspond to a particular land use in a
human health scenario. You may just want to set your vertical layers so that you no longer have
so many data plotted on top of each other in the graphics window. Let’s use this later reasoning
and setup a new layering design called MyThinLayers. In Chapter 4, we covered how to setup a
layering design. If you can’t recall how to do this, please review that chapter. Very briefly
though, press the Add button next to the box showing Entire Data Layer. Enter the name
MyThinLayers and base the design on a new layer design. In the layer editor, create a 0-2 layer,
a 2-5 layer, and then thereafter all 5 foot intervals. Before finishing, make sure your entries
match the following:
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*u, Edit Layer Design S‘
Current Layering Design Details
Fram To Palygon Active Remedial Threshold The table below allows you to contral the behavior of
* |D 12 ‘None ﬂh-es ﬂ|ﬂ each layer in this layering scheme.

|2 |5 ‘None ﬂ|‘r’es ﬂ|ﬂ From

|5 |1D ‘None ﬂ|‘r’es ﬂ|ﬂ The top of the layer measured as depth from
surface. Points with this exact depth value will be

|1D |15 ‘None ﬂ|‘r’es ﬂ|ﬂ found in this same layer.

15 [20 |None > ||ves ~|p To

PD 125 ‘None ﬂ|‘r’es ﬂ|ﬂ The buottom of the layer measured as depth from

S R T S s ot o

|ED 135 ‘None ﬂ|‘r’es ﬂ|ﬂ isn't a deeper layer, they are excluded.

23 10 [None = ||es ~ljo Polygon

|fiD |’15 ‘NU”E j|‘r’es ﬂ|ﬂ This is the name of the polygon layer you wish to

I45 ISD JNone j|‘f’95 ﬂ|g apply to this vertical layer.
Active

Turns a vertical layer on or offt. If true, then the
layer is tumed off.

Remedial Threshold

In some situations, the user iz allowed to specify a
decision criteria (e.g. screening value, cleanup
criteria) as a function of depth. This is an opportunity
to specify those depth dependent values.

Add ‘ Delete ‘ Check |

Help ‘ 0K ‘ Cancel ‘

When you press OK, you'll see your new layering design has been applied. Now you can
peruse through the data set and see a little more clearly what is going on. Not all the hash
marks are gone, but it's definitely an improvement. Notice that in the upper-left-hand corner it
looks like some of the data we saw in the previous view using the Entire Data Layer has now
been lost. This is not the case. Those data points are just located in a deeper layer than our
current 0<=z<2 layer. To see for yourself, just choose a different layer from the Set Vertical
Layers drop-down box.
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Notice now you are looking
at your first layer 0-2.

i

In the previous view, you
" had data up here. It isn’t
gone. It was actually found
lower down than 2 feet so it
doesn’'t show up in this
layer view.

Chlordane Samples
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If you select deeper and deeper layers, you can see that we have an elevated set of data values
in the center of the site. The elevated values seem to move south as you move deeper. This is
very important to notice, as it likely indicates the presence of a plume. Go ahead now and save
your file.

A brief look at the 3d Viewer

You can look at the data by slice or look at it all at once using the 3d view. Be aware that 3d
viewers are worlds of their own, worthy of their chapter (see Chapter 44, “The 3D Viewer”). Let’s
turn on the 3d viewer to show you it's there and show you a few tricks that are worth knowing.
To see the 3d viewer, select from the Graphics Menu-2Show 3d View. You should see
something like the following diagram.

Note: 3d viewers take longer to render than 2d viewers, and SADA is no different. We
recommend that when you are doing most of your analyses you leave the 3d viewer turned off.
In addition, many tools are not available when the 3d viewer is on. The 2d viewer should be
your primary base of operation.
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Chlordane Samples

Subtitle 1.05

084

r0.63

r0.42

0.21

0.00

IMPORTANT TIP!!!
0 Depending on the video card you have, the 3d viewer may act temperamental. If

— you don’t see this view or see “remnants” of the last window you had open in its
place, just click anywhere in the 3d viewer to refresh it.

Most of the time, for environmental data, the vertical extent is considerably smaller than the
horizontal extent. For this reason, when you view the results in 3d your site looks “pancaked” or
mashed flat. So, the first thing you’ll want to do is exaggerate the z direction.

Click on the step 3d Viewer Controls (this is a new step that popped up when you turned the 3d
viewer on). This parameter window has quite a few tabs and can be intimidating at first. These
features are taken up in greater detail in Chapter 44. Really though, most of the time you'll
repeatedly use only a few of the features. Scroll to the right in the window and click on the
Scaling tab. You should have the following view.
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~ | ™ 3D Options

. See the data Basic | ChairCut/Shells | Slicing | Labels | Views Sealing | Points | Ele
. Set up the site

. Set GIS overlays A 1
. Show the results
. Autodocumentation i !
. Format picture
Z 1
. Export to file
. 3D Viewer Controls Eaih IF

Show The Results

In the Z parameter box, enter a value of 10 and press the Enter key on your keyboard. You
should see the following change in your 3d view. Again, if you don’t see a change, just mouse
click anywhere in the 3d view.

" Chlordane Samples gj

Chlordane Samples

Subtitle LoE

-0.84

FOB3

r0.42

0.00

Rotating the view is easy. Just left mouse click and hold anywhere in the 3d viewer area. Now
drag your mouse and you’ll see the image begin rotating. The best way to learn how to rotate is
to just play around with moving your mouse in different directions.

If the axis labels are annoying, you can get rid of them by right-mouse-clicking on the axis they
belong too. They turn off and on accordingly.

You can now see the location of the elevated zone in the subsurface very easily by rotating the
3d results into different positions.

108



Chapter 11: Visualizing and Exploring Your Data

You can now turn off all the lower value points so you see your results better. To the right of the
Scaling tab you'll find the Points tab. Click on this tab. Select the Value at least option and enter
a value of 0.1. This will eliminate any measured values below a value of 0.1 mg/L (recall that
SADA doesn’t track units; these are selected by the user. The exception is when doing risk
assessment.)

" 3D Options h

Basic | ChairCut/Shells | Siicing | Labels | Views | Scaling Points | Ele

I

Chlordane Samples
Subtitle

o 1

all points
& Value at least |1 T

" Walue at most

“alue betwaen and

Now you can clearly see the elevated values in the 3d viewer. Unfortunately, we don’t have a
GIS layer at this point for reference. If you did, the 3d viewer would draw it on the top of the 3d
cube. Note: Sometimes you need to click on the 3d viewer window to refresh or recalculate your
view.

Let’s turn the 3d viewer off by choosing Graphics 2Show 3d Viewer. The menu item acts like a
toggle and will turn the 3d viewer off and on.
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Getting Information About Your Data

There are a number of ways to query the SADA file for information about the data you are
seeking. The first way is to use the meta labels drop-down box. Remember that SADA allows
you to import all required or useful fields as well as any other field you may have.

[Piotmy data =l

|General | |Groundwater | |chiordane ~ | [ ~ | |0 =Z2<2 hd

Meta labels drop down

Let’s begin with an option in the drop down box that actually isn't a field in your data base. If you
scroll to the bottom of the fields you’ll see an entry called Plotted Value. This is a dynamically
labeled result, whereby the exact value of the currently plotted value at each location is
reported. Let’'s select this item now.

Faned vae =] [0z <2 -

Chlordane Samples
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You'll see the concentration values that are currently plotted appear as small labels to the lower
right of each point. Now select the field named Values. This is actually the field in the data set
that was matched to SADA'’s required Values information type. Nothing much has changed. So
the question arises, what is the difference between Plotted Value and Values? Values comes
from your data set and is the actual measured value for each point. Plotted Value is the value
that is plotted at each sample location in the current view. In this example, they are the same,
but they are not always equal. Consider a point risk plot. Each plotted value might be a
carcinogenic risk value and not a concentration value.

In actuality, even in this example, there is a difference between the two. With Values selected
as your meta label, notice the label result “***” in the upper-right-hand portion of the picture.
Anytime you see the three asterisks like this, it means this sample location contained a
duplicate value. Therefore, SADA doesn’t know what to provide as the meta label value. The
only exception would be the selection Plotted Value. In that case, SADA has followed the rules
regarding duplicates and resolved the duplicate values to a single value that can be plotted. For
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all other cases, however, there is more than one possible answer. In this case, the asterisks are
used. This is an excellent way to quickly visualize where your duplicates are found.

This is a duplicate.
Chlordane Samples

106

You can switch to other labels and view a single database result for all the visible samples at
once. The numerical values are formatted according to whatever format is used for the legend.

Alternatively, you can look at all the meta data values for a single point. To do this, simply click
on a data point of interest. SADA responds by showing you a popup window containing all the
information about the point you clicked on. If the point you clicked still has hash marks around it,
(indicating deeper samples within the same layer are also there) you’ll get all the information for
each value found at the easting/northing location within the current layer.

®w Data Point Query g|

..................................................... 2757071
Al 22905.8408
Z 1.716
CAS 1234123
MNames Chlordane
valles 0.04592
Detect 1

tedia Gy

Date 322018994
WellD DP-113
SAMP_DATE A/15/1997
SURELE g58.1
SAMPELE 32

Plotted Walue

Try now also clicking on the duplicate location.

Chlordane Samples

/
/

You will see instead the following in your data point query window:
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“w Data Point Query B|
Field Walle

hd 278
Y 23068
Z

CAS -

Mames Chlordane

Values 0.0
Detect b

Wedia i

Date e

WelllD -

SAMP_DATE -

SURELE i

SAMPELE e

Plotted walue 0.0
| 4 ‘ ‘ >|

Blue values indicate that this result is a constructed result and is based on multiple values. The
blue also indicates that, much like a hyperlink, you can click on the result in this window and
“drill down” to see what values were used to construct this result. Click now on any blue text in
this window and you’ll see a second window pop up with information on the two duplicates that
were resolved at this location.

™ Duplicate Data

The following are all duplicates found at the specified point. Only detected duplicate values were
considered. f maore than one was available, the maximum walue was chosen.

X K [z [cas [Marmes  [values  |Detect Media Date
27AAA 21 F30A9 3147 1612 1234123 Chiordane . 0.01289 16w 3429/
27868.21('3069.3142 1612 1234123 Chiordane | 0.02554 16w 322

Close both of these windows now.

You can also get all the information for all the points at once by choosing from the main menu
Tools 2Information. Alternatively, you can simply press the Information button on the main
toolbar (see the help file for more information).You will be presented with the data grid showing
you results for all the data.
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E)

OX)

i

2727389
2727389
2727389
27e7ing
2727389
2727389
27e7ing
2727389
2727389
2727389
275129
27h12.41
27812491
27512.9
27h12.41
27812491
27n12m
27812491
27h12.41
27h12.41
2751241

4

s
23261.1592
23261.1552
23261.1682
23261.1552
23261.1592
23261.1682
23261.1552
23261.1592
23261.1682
23261.1582
23260.989
23260.988
23260.989
23260.989
23260.988
23260.989
23260.969
23260.989
23260.988
23260.989
23260989

2b
5.2
78
K]
13
186
1682
208
234
26
2B
b2
78
104
13
1586
a2
208
234
26
286

CaS

1234123
1234123
1234123
1234123
1234123
1234123
1234123
1234123
1234123
1234123
1234123
123123
1234123
1234123
123123
1234123
1234123
1234123
1234123
1234123
1234123

MNames

Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane
Chlordane

Walues Detect Media
0.00015 1 G
n.oo0z? 1 GwW
0.00046 1 GW
0.00045 1 G
0.00023 1 GW
n.oo01z2 1 GwW
0.00004 1 G
0 1 GW
0 1 GwW
0 1 G
0.46147 1 Gw
0.69144 1 GwW
0.73024 1 GW
0.38323 1 Gw
012108 1 GwW
0.027249 1 GW
0.00492 1 G
0.00076 1 GwW
0.00011 1 GW
0.00001 1 G
0 1 GW

3

Scroll to the bottom of the grid, and you’ll see the duplicate value again represented by blue
text. Click on this line in the grid to drill down further and see the duplicates involved in the
processes, as before.

Recall that you can use polygon tools to subset areas of the data or even turn layers on and off
to exclude or include data. Let's see how that works. Close this window and return to Set up the

site.

Underneath your selection of MyThinLayers, double click in the layer list box to bring up the
layer editor window again. Turn all the layers off (choose No in the Active column) except the
top layer. Your window should look like this before you close it.

"™w Edit Layer Design

Current Layeting Design

From To Polygon Active Remedial Threshold
* |EI ‘2 |Nnne jl\’es ﬂlﬂ
|2 lE |Nune L“NU ﬂlﬂ
3 [0 [Mone o ~|p
1o [15 [Mone < [na ~fp
[15 20 [Mone = o ~|fp
|20 ‘25 |Nnne j|Nn ﬂlﬂ
[ [z0 [Mone o o
[0 s [Mone B ~lp
[ ] [Mone Mo ~|p
20 45 [Mone > |[Mo ~p
45 [z0 [Mone Mo ~p

Details
The table below allows you to contral the behavior of
each layer in this layering scheme
From

The top of the layer measured as depth from
surface. Points with this exact depth value will be
found in this same layer.

To

The bottom of the layer measured as depth from
surface. Points with this exact depth value are not in
this layer. They will be in the next layer or if there
isn't a deeper layer, they are excluded.

Polygon

This is the name of the polygon layer you wish to
apply to this vertical layer.

Active

Turns a vertical layer on or off. If true, then the
layer is tumed off.

Remedial Threshold

In some situations, the user is allowed to specify a
decision criteria (e.g. screening value, cleanup
criteria) as a function of depth. This is an opportunity
to specify those depth dependent values

Add | Delete ‘ Check

Help | oK ‘ Cancel ‘

X
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Notice that in all layers except 0 to 2, the sample points are not colored. This indicates that they
are not currently included. Only those points 0<=z<2 will be included.

Chlordane Samples

TR =

Morthing

=R T ;EEO F-SEIRE
Easting

Now press your information button or choose Tools -?Information. Notice that the data grid now
contains only the top layer of points. Close the window.

We will now continue the discussion on data exploration using another file that highlights some
different exploration tools. Close MyThreeDimensionalStart.sda and when asked to save, say
Yes.

Pooling your data sets
Open the file Twodimensional.sda and save it as MyTwoDimensional.sda. If the file already

exists, you can overwrite it. When SADA first brings a file up, you will always be presented with
the results of one of your data sets. In this case, we see Ac-225 soil.
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We saw in the previous section how to get information on a single dataset, like Chlordane or Ac-
225. You can also get information on all contaminants at once in exactly the same way. Using
your data set drop down list, switch from Ac-225 to Pooled Data. The sample locations will turn
black.

With this photo in the background, it is difficult to see where they are. To change the color of
your pooled data points, select from the main menu Graphics 2Set Various Colors 2Pooled
Data Point Color and choose instead yellow.

Save your file. Using your mouse, click on any one of the sample locations and you will be
presented with the Data Point Query window filled mostly with the words Pooled.
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“w Data Point Query

Field Walle

Easting 27
Narthing 2
Depth

Casnumber Pooled

Marme Pooled Data

Walue Pooled

Detected Pooled

Media Pooled

Date Pooled

SamplelD Pooled

Region Pooled

Plotted value ‘Pooled

4 3

Like in the case of duplicates, since there are multiple points at this location (in this case
multiple contaminants), it is impossible to report field values. Again, click on one of the blue text
entries to drill down and see what data sets are located at that point.

™% Pooled Data Point

Easting |MNorthing |Depth |Casnumber MNarme

276855 | 14265851 Ac-225
7440393 Barium
7440382 Arsenic

276855 12maz? Anthracens

Close both of these windows now.

The Information button (or Tools *Information) will now show all the contaminants at once.
Select this option now and you should see the following result:
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*x Information Retrieval E‘E‘g|

IR

Easting Marthing Depth Casnumber MNarne “alue Detected Media -
2831025 23400 0 14265851 Ac-22Zh 31 1 30

28530 22700 0 14265851 Ac22h 33 1 50

28667 25 23220 ] 14265851 Ac-225 24 1 50

28700 22500 ] 14265851 Ac-225 33 1 50

28709 22900 ] 14265651 Ac-22h 27 1 50

20935 21900 0 14265851 Ac-22h [IR:| 1 S0

20935 23460 0 14265851 Ac-22h 0a 1 S0

28984 22787 0 14265851 A2 26 1 20

281135 22980 0 14265851 Ac-2Zh 1 1 30

28920275 22500 0 14265851 Ac-2Zh 15 1 30

27026 22129 0 7440343 Barium 43.2 1 50

27150 23160 0 7440343 Barium 364 1 30

27200 22380 0 7440343 Barium 433 1 30

27350 22780 0 7440343 Barium 7849 1 30

2741775 23580 ] 7440343 Barium 41 1 50

27500 23270 ] 7440343 Barium 75 1 50

27h46.25 21300 ] 74403493 Barium 427 1 50

27650 22500 0 7440393 Barium 98.2 1 S0

276855 22200 0 7440393 Barium 435 1 S0

276855 22920 0 74403493 Barium 493 1 S0

27640 23380 0 7440343 Barium 781 1 20 -
4 »

Scroll down through the rows to see all the soil contaminants. Close the window when you're
done.

The method of using meta-data labels is somewhat less helpful. Only in those cases where the
field value is exactly the same for all entries will the result show anything other than Pooled.

Select Media from the drop-down meta labels list.

Again the black text is difficult to read. Select Graphics »Set Various Label Colors >Label
Colors and change to yellow. You can now see that every point has the symbol SO next to it.
This means that for every contaminant measured at that location, every result had a media field
value exactly equal to SO. This in fact should be the case, since we are looking at soil data.
Now switch to Value. Notice that every sample point except for two has the familiar three
asterisks.
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The reason that two of the sample points do report values of 25.20 and 34.40 doesn’t mean that
all soil contaminants measured there were exactly these values. In this case, it turns that there
was only one contaminant measured at both those locations (Arsenic).

You may close your file now. If you wish, you may choose to save the file.
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Chapter 12: Statistics
Once you have imported your data or created a geospatial model, you may wish to calculate

some simple statistics, run some simple tests, or see some traditional plots. On the main menu,
you'll find the Statistics menu item, which contains most of the standard statistical features

provided.

Univariate

Show Histogram

Show COF

Statistical Tests »
Number Of Samples »

MARSSIM Quick Caloulations L
3d Hot Spot Search Efficiency

Let’s begin by opening the file Statistics.sda (File *Open and navigate to where SADA is
installed). SADA opens up your file with the soil measurements for Ac-225.

Univariate
This feature will show you a collection of standard statistical endpoints, such as mean, variance

and so forth, for the currently selected contaminant. In this case, we have Ac-225 selected.
Choose Statistics 2Univariate and the following window is presented. Or you can press the

statistics button on the toolbar.
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24 Univariate Statistics

- Univariate Statiztics

¥ Detects I~ Range I Minimum Detect [~ Min Easting & i (Bl o ol e —
WM ¥ Interquartile Fange I~ Marximum Detect [~ Max Easting * Azcending

[~ Mean I~ UCL3S (Nomal- Studert's 1] [ Minimom Mondetect [ Min Marthing " Descending

I~ Median I~ UCL3S (Lognommal Land's HY T Masimum Nondetect [~ Max Northing

I~ Marahce I W Minirmurm Dwerall [ Min Depth

|~ Standard Deviation I~ Kurtosiz v Masirumn Overal [~ Max Depth ﬂl

v Geometric Mean [~ Mean dbsolute Deviation

[~ Coefficient of Yariance

Analyte | Detects [M | Geometric Mean | Interquartile Range | Minimum Overall | Masimum Overall
Ac-225 28 28 2392528 1:5

You can choose which statistical values you want to see by selecting or deselecting them in the
top half of the window. Also, you can sort columns by different values. Simply click on the
column you want to sort and SADA will sort them according to the sort selection (found on the
right hand side). Continue reading for details on each statistical endpoint.

Detects
The number of total samples that were detected, presented in the form (detected/total N).

The total number of values.

Mean

The sum of the values of a variable divided by the number of values.

__I?'-'
X-;gx
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Median

The value below which 50% of the data values fall.

odd n —
X = ‘X([:H-I]-’E)
even n ¥ - Xony * X([n.-'z]u:
2
Variance

A parameter that measures how dispersed a random variable’s probability distribution is, the
mean of the squares of the differences between the respective samples and their mean.

T(x-X)

-1

S 2
Standard Deviation

The positive square root of the variance.

Geometric Mean

The mean of n numbers expressed as the nth root of their product.
1 n
exp |— Y Inux;
o[ 5]

Coefficient of Variance

The ratio of the variance over the mean .

| l I
- n-li

(XJ-‘X)E || 2
CV=s/X !
E535¢
n =1

Range

The difference between the lowest and highest values.

R = maximum - minimum
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Interquartile Range

The central portion of a distribution, calculated as the difference between the third quartile
and the first quartile; this range includes about one-half of the observations in the set.

IQR = y(75) - y(25)

UCL95 (Normal — Student’s t)
Upper 95% confidence limit on the mean concentration of a normal distribution.

UCL95 (Lognormal — Land’s H)
Upper 95% confidence limit on the mean concentration of a lognormal distribution.

Skewness

A measure of symmetry, skewness for a normal distribution is zero, and any symmetric data
should have skewness near zero. Negative values for the skewness indicate data that are
skewed left and positive values for the skewness indicate data that are skewed right.

1 N o — T\
_ i
h=5 2 (%)

'
=1
Negatively Svinmetric Positively
Skewed (Mot Skewed) Skewed

Kurtosis

Kurtosis is a measure of whether the data are peaked or flat relative to a normal distribution.
Data sets with high kurtosis tend to have a distinct peak near the mean, decline rather
rapidly, and have heavy tails. Data sets with low kurtosis tend to have a flat top near the
mean rather than a sharp peak.

1 al Ij —T *
=52 (27
i=1
Kurtosis can be grouped into three broad categories
o Leptokurtic: high and thin (high kurtosis values)
e Mesokurtic: normal in shape

e Platykurtic: flat and spread out (low kurtosis values)
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Mesokurtic

Platykurtic

AH o

Mean Absolute Deviation

Chapter 12: Statistics

The mean of the absolute values of the differences between the respective samples and

their mean.

YN ]
N

Minimum Detect
The lowest detect value found in the dataset.

Maximum Detect

The highest detected value found in the dataset.

Minimum Non-detect

The lowest detect value found in the dataset.

Maximum Non-detect

The highest detected value found in the dataset.

Minimum Overall

The lowest detect value found in the dataset.

Maximum Overall

The highest detected value found in the dataset.

Min Easting

Smallest easting coordinate value.

Max Easting

Largest easting coordinate value.
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Min Northing
Smallest northing coordinate value.

Max Northing
Largest northing coordinate value.

Min Depth
Smallest depth below surface value.

Max Depth
Largest depth below surface value.

Obviously, certain univariate statistics would have little meaning when applied to a set of model
values. For example, the upper confidence limit on the mean is meaningless, since it is a
function of the number of values, and the number of cells in a grid can be easily varied.

Show Histogram

Looking at the histogram of values is very valuable in getting a visual sense for the distribution
of your results. The histogram is always shown for the current result in your map. Of course,
histograms are not available for everything that may appear in your viewer (e.g., cost benefit
analysis). The menu item Statistics = Show Histogram will show the histogram view. Select this
menu Now.

[~ x|

Ac-225 Histogram

Frequency

0o

Values

The Show Histogram menu actually acts as a toggle. Select it again to switch back to your
spatial view.
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Show CDF

The cumulative distribution function, or CDF, is a natural companion to the histogram and is the
focus of evaluation for certain geospatial models (e.g., indicator kriging). To see the CDF, select
Statistics 2Show CDF and the following result appears in your viewer for Ac-225.

Ac-225 CDF

Cumulative Freg.

0m T 1 T 1
am 182 244 1% am 490

Concentration

On the x-axis is the range of Ac-225 concentration values. On the y-axis is the percentage or,
more accurately, the proportion of data values that fall below a given concentration value. So for
an x-axis reading of 0.80, we have no data that fall below this value, since this is the smallest
Ac-225 reading in the data set. The top reading of 4.90 pCi/g shows a value near 1.0, as this is
the highest value in the data set.

You can use the Line Query tool to directly read up to 3 values from the line. Select this button

now.
?
7

You will be presented with this window.

You i o

and ZADA wall vead off thal graph the exact valee for independent (x) value, Mote that in o

sduations the graph is created by linear interpolation throwgh some points. In that case, if you

i mot ewactly an A paird, you wall get back the v value of the inemolated Ene. In that sense, 8 is
al

Scenario 1 Scenario 2 Seenann 3

4 Clear Row

¥ Hosult with sarme

Here, Scenario just means a particular x value. Enter 2 and 4 into Scenario 1 and Scenario 2,
respectively. Press Calculate and SADA calculates that the proportion of sample values below 2
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is 0.29 and 4 is 0.86. Note that you can match the format of reported CDF values with the y axis
in the CDF plot by checking the option at the bottom of the window. The Line Query tool can be
used with cost benefit plots as well.

Press the Quit button.
Statistical Tests

A statistical test is a procedure for deciding whether a hypothesis about a population of values is
true or false. For example, one might hypothesize that the mean of the population is less than 5
pCi/g. Of course, the only way to know for certain is to have access to the entire population of
values. Here, the population would be the exhaustive set of Ac-225 measurements (e.g., a
measured value of Ac-225 for every single location on the site). This of course is impossible.
Instead, only a sample of the population is available. Therefore, statistical tests are used to
draw a reasonable conclusion about the hypothesis when the entire data set is not available.

Furthermore, statistical tests are instrumental in separating significant effects from mere luck or
random chance. For example, suppose that you flipped a coin twice, landing on tails both times.
We know that a fair coin should see heads 50% of the time. With so few flips (only 2) we cannot
conclude whether the coin is fair or not. We might have tails two times in a row by mere luck, or
it might be true that the coin is biased so badly we would get tails every single time. A statistical
test would inform us that we cannot separate out luck from true bias in this situation. After 100
flips, however, a test could discern the difference. This is the power of a statistical test.

Of course, without the full population at hand, any conclusion drawn is at risk for error.
Fortunately this risk is quantifiable. Two main types of error can occur:

1. Atype | error occurs when a true hypothesis is rejected (a false negative in terms of the
null hypothesis).

2. Atype Il error occurs when a false hypothesis is accepted (a false positive in terms of
the null hypothesis).

Decision Based on Sample True Condition
Data . o
Baseline is True Alternative is True
Decide baseline is true Correct Decision Decision Error (False Acceptance)
Decide alternative is true Decision Evror (False Rejection) | Correct Decision

*Taken from Guidance for the Data Quality Objectives Process USEPA 2000 QA/G-5, EPA/600/R-96/055

Officially speaking, a null hypothesis is a statistical hypothesis that is tested for possible
rejection. The alternative hypothesis is the hypothesis contrary to the null hypothesis.

The process for a statistical test is broadly conducted as follows. First, form a hypothesis about
some statistical endpoint (e.g., the mean < 5) of your population. This is your null hypothesis
and the test will attempt to reject it by evaluation of the data. Next, draw a random sample from
the population (this is the Ac-225 data you have currently selected). Typically, an assumption
about the underlying distribution is made (e.g., normal distribution). Using this assumption,
choose an appropriate statistical test and compare the result to a critical level.
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There are two broad types of statistical tests: parametric and non-parametric. A parametric test
makes an assumption about the underlying distribution of observed data. A non-parametric test
makes no such assumption.

In particular, non-parametric tests do not assume normal distributions, can handle non-detects
(which often cause truncated distribution shapes), are insensitive to outliers and work nearly as
well as their parametric counterparts when applied to normally distributed data.

SADA currently implements two non-parametric tests used by the MARSSIM processes: the
Sign Test and the Wilcoxon Rank Sum Test.

Whether parametric or nonparametric, there are two different types of test you can conduct: two
sided and one sided. A two sided hypothesis states that there is a difference between the two
groups (or values) being tested, but does not specify in advance what direction this difference
will be. In an environmental context, one group might be Ac-225 measurements in the
contaminated area. The second group could be Ac-225 measurements in background. The
hypothesis could be that there is no difference between the two groups. A one sided hypothesis
states a specific direction (e.g., the site concentrations are greater than the reference site
concentrations).

We now present the two nonparametric tests that SADA provides: Sign and Wilcoxon Rank
Sum (WRS) Test.

Sign Test

In a sign test, we do the following. First, take the difference between each measured value and
the decision criterion. Some measured values will be less than the criterion and will produce a
negative difference. Some measured values will be greater than the criterion and will produce a
positive difference. Some measured values may be exactly equal to the decision criterion,
producing a difference of zero. In the following example, we’ve taken some Arsenic
measurements and calculated the difference between them and a decision criterion of 10mg/kg.

Arsenic Criteria Difference Sign
12 10 2 +
28 10 18 +
8 10 -2 -
42 10 32 +
16 10 6 +
23 10 13 +
45 10 35 +
31 10 21 +

The sign test, true to its name, only cares about whether the sign of the result is positive or
negative, as seen in the last column. How large or small the difference is becomes irrelevant.
What the sign test does is test whether the number of +’s and —'s are equal. Because of this
formulation, the sign test uses wording in the null and alternative hypotheses that is a bit
unintuitive, so let's take some time with it. The null and alternative hypotheses (Gilbert 1987, p.
242) are written as follows.

¢ HO: the median of the population of all possible differences is zero.
¢ H1: the median of the population of all possible difference does not equal zero.

Let’s stop for a moment and understand what is being said here with less formal language. Let’s
start with the “population of all possible differences.” If you could take every single Arsenic
measurement of the site, you would have the population of Arsenic values. If you then
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subtracted them from the decision criterion (10mg/kg) and noted the number of +'s and —'s, you
would move yourself from the population of measurements to the population of differences.

In the table above, we are subtracting measured values from the decision criterion and ending
up with differences from which we record the number of +'s and —'s. So, we move ourselves
from the sample of “measured values” to a sample of “differences.”

Why do we care about the median of these differences? If the population (not the sample) of
differences has exactly the same number of +'s as there are —s, then we have central or
median value of zero. Think of these as +1s and -1s, and if you have the same number, then
the median of these would be halfway between or zero. Note that if you end up with any
difference of exactly zero, it is thrown out (Gilbert 1987).

So what does this have to do with determining if our site is contaminated or not? Let’s start by
reformulating the hypothesis into an equivalent statement.

o HO: Measured values are just as likely to exceed the criteria as they are to be less than
the criteria.

e H1: One of the following is true:
0 measured values are more likely to exceed the criteria.
0 measured values are more likely to be less than the criteria.

These are equivalent to the first formulation. In environmental assessment, we are more likely to
be interested in H1A. We could then rewrite this as the following.

o HO: Measured values are just as likely to exceed the criteria as they are to be less than
the criteria.

e H1: Measured values are more likely to exceed the criteria.
For the example we show above, let’s write this one more time very specifically.

¢ HO: Arsenic values are just as likely to exceed 10mg/kg as they are to be less than
10mg/kg.

e H1: Arsenic values are more likely to exceed 10mg/kg.

The critical value used to conduct this one-sided test is provided as the number of +s that you
must have to reject the null, and it comes from the binomial distribution. The sign test critical
value tables can be found in introductory statistics books. In SADA, it is computed directly. Let's
test the hypothesis now.

In our example, we want to be very sure that if we do reject the null hypothesis, we want there
to be only a 5% chance we did the wrong thing. This is the type | error we talked about earlier.
This value is referred to as alpha (so we have alpha = .05). The next thing we need is test
statistic B and a critical value to compare it to for alpha = .05.

In our example, counting up the number of samples yields N=8 and the number of exceedances
is B=7. Now, turning to the binomial distribution table (most statistics books have the table in the
back) for a one-sided sign test with alpha = .05, N=8, and B = 7, we see the critical value is also
7. Therefore, since our test statistic equals the critical value, we are led to reject the null
hypothesis. Since we computed the number of exceedances as our test statistic, this would in
fact indicate the median is exceeding 10 mg/kg. This means that more often than not, Arsenic
values exceed the decision criterion. When we apply our decision rule, we infer that the site is
contaminated.
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To use the sign test in our current file, select from the main menu Statistics »Statistical Tests>
Sign Test vs Decision Criteria. If you are working under General analysis, you will be presented
with the following window asking for a decision criterion.

®x User Defined Decision Criteria

LIser defined decision goal

Ok Cancel

The Human Health, Ecological, and Custom analyses would present their usual windows for
choosing decision criteria. These will be covered a little later. Enter a value of 3 here (pCi/g) and
press OK. The Sign Test window is presented. At the top are the null and alternative
hypotheses. Note: The two-sided alternative is written there, but the one-sided formulation
would have been more appropriate. Look for updates as SADA releases continue.
Nevertheless, we are doing a one-sided upper test where the HA is that the median exceeds
zero.

5i, One-Sided Sign Test

2| 6|7 =

Ac-226 - User Defined = 3
Mull {Ho) and Alternative (Ha) Hypotheses
Ho = The median of the population of all possible differences is 0

Ha = The median difference does not equal 0.

Test Stafistics
One-Sided Test

alpha="|nns -

10+18- MN=28(0 Ties)

alpha =005 upper=18

Test Results

Ac-225 does not exceed User Defined = 3

There are 10 exceedances and the upper test statistic is 18, Since the
nurmber of exceedances is less (or egual to) the upper test statistic the
null hypothesis is accepted.

Atalpha =005, Hois accepted and Ha is rejected. The median of

the population of all possible differences is 0. Ac-225 does nottend to
exceed User Defined = 3 any more likely than the reverse

Help

So, at alpha = 0.05, with N=28, a decision criteria of 3pCi/g, and a test statistic of 18, we cannot
conclude that the median of Ac-225 values exceeds 3 because we only have 10 exceedances.

Wilcoxon Rank Sum Test (WRS)

The WRS is another non-parametric test that is implemented as either a one-sided or a two-
sided test in SADA. In this case you compare one contaminant data set versus another data set
(e.g., background).

Specifically, the WRS test uses a sum-of-ranks comparison to determine if the two data sets
have different means. The process is conducted as follows. First, combine data sets and order
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from lowest to highest, each data value receives a rank (e.g., 1%, 2nd 3rd etc). Sum the ranks for
the two different populations and compute the WRS test statistic (different forms depending on if
there are ties). Compare to critical value for m and n sample sizes. Null hypothesis is either
accepted or rejected.

To see how this works, first open the file RadWithBackround.sda (you can save your current file

or not). This SADA file contains some synthetic radiological data along with some background
measurements. With Soil selected, choose Radionuclide B. You should see the following map:

To see the background data, select Background instead of Soil. The background data for
Radionuclide B will display, since it is the first and only background dataset in this file.

L=

1290

Next, we will perform the WRS test to see if the site data is greater than the background. To do
this, select from the main menu Statistics »Statistical Tests sWilcoxon Rank Sum, and the WRS
test feature is initiated with the following window. Select in this window the two data sets you
want to compare. In this case, select Radionuclide B from the left window and Radionuclide B
Background from the right window. SADA shows a preview of each.
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First Data Second Data

‘Sm\

‘Hadmnuchde B ‘Rad B Background

‘Surface Qnly

L L Lo Ll

-
[=1
| Surface Only ~|
<]

z=0

lz=0

IWEE

12

I138

127
11.7] 11.4
10.7) 10.4)

9.73

I™ Use colocated data only Cancel | Help |

Two important points should be brought to your attention here. First, in the lower-left-hand
corner is the option Use collocated data only. There are some situations where data occur
concurrently and this may be appropriate. In this example, where we are comparing site and
background data, we have no collocated data and so this is not appropriate.

Secondly, notice that you can select layering schemes as well. This is important. You may want
to set up a particular layering scheme with polygons embedded in such a way as to include or
exclude a set of data. For example, you may have background data from two locations and wish
to exclude one while you use the other. In the other dataset selection, a different
layering/polygon scheme may be appropriate. This permits you the flexibility to spatially zero in
on two or more different locations when doing the WRS test. In this example, we will use the
Surface Only layer with no polygons other than our site boundary polygons.

Press OK.
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=i Wilcoxon Rank Sum Test

Fadionuclide B - Rad B Background
MHull (Ha) and Alternative (Ha) Hypotheses value |DataSet|Bank Tied?
Ha = The underlying distributions of the two contaminants are equal. 4] Radionul1 False
8.8 FadBE 2 False
Ha = The underlying distributions of the two contaminants are not 8.9 P\ad?onu 3 False
equal. 9.21 Radionu 4 False
9.3 RadBE B True
o 9.3 RadBE B True
Test Statistics 93 FadBE & False
TSl = 976 |Radionu/ 8 False
alpha = 0.1 - 3.9 Radionu 10 True
m=21 n=21 949 Fadionu 10 True
Radionuclide & Mean = 10.7185714 Variance = 13931929 18 |RedBB 1D False
10 RadBE 12 False
) ) 10.1 Radionu 135 True
5 f Fanks for Rad lida B =4515
Him BTREHES Tor Facionueise 101 |RadBB 135 False
_ 10.2 FadBE 155 True
Rad B Background Mean = 10.6761405 Variance = 1.1619048 0z Fad BB 155 False
10.3 Radionu 18 True
Sum of Ranks for Rad B Background = 451.5 103 Fiadionu 18 True
103 FadBE 18 False
10,77 Radionu 20 False
WRS Critical Walue = 502 10.8 Radionu 215 Ttue
10.8 FadBE 215 False
Test Results 10.9 Radionu 23.5 True
Fadionuclide B(1) does not exceed Rad B Background(2) (or 10.9 FadBE 235 False
wvice-versa). 11 Fadionu| 26 True
11 FadBE 25 Ti
Meither of the surm of ranks for contaminant ane (451.5) or for 1 Rad BB 76 FrTe
contaminant twa (451 .5) exceed the test critical walue (502). Therefare, = - alee
the null hypothesis is accepted. 1105 |Radionu 28 False
1.2 Radionu 29.5 True
Atalpha = 0.1, Ha is accepted and Ha is rejected. The medians of 1.2 FadBE 235 False
Radionuclide B and Rad B Background are not significantly different. 13 Fadionu 31 False
11.4 Fadionu 32.5 True -

Here the null hypothesis is that the two groups are the same (site is no different than
background). The alternative is that they are different. At the alpha value of .1, we accept the
null hypothesis that the two populations are different and might conclude the site is clean. Had
the null been rejected, SADA would have also conducted a one-sided test to determine if the
site data in fact exceeds background.

Number of Samples

This topic is handled in the Chapter, “Overview of Sample Designs.”

MARSSIM Quick Calculations

This topic is handled in Chapter 40, “MARSSIM.”

3d Search Efficiency

Among SADA’s many sampling strategies is the 3d Hot Spot search design, where a 3d grid of
candidate locations is positioned on the site and the probability of discovering a particular 3d
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volume by sampling in those locations is calculated (see Chapter 39). In this feature, we
generalize it to any sample design, gridded or not, and apply it to existing sample designs. In
other words, to use this feature, you will need to import your data first. There are a couple of
situations in which this feature can be useful.

First, a 3d search grid was implemented in the past, but when the samples were taken,
adjustments had to be made due to physical obstructions or cost. This feature can analyze your
resulting design and see how the probability of finding a 3d hotspot might be affected.

Second, the data you have may originate from a sample design that was not primarily interested
in searching for a volume of a given size. Now the issue has arisen, however, and the interest is
in evaluating how well it serves the 3d discovery objective.

The details of this feature are found in the Chapter 39 “Standard Initial Sample Designs” under
the 3d Hot Spot Search discussion. You are encouraged to read that material first. We will point
out here that the only difference in the interface is that under the sample design strategy, you
will enter a candidate 3d grid which is then evaluated. Under this feature, the currently selected
design is evaluated.

New 3D Sample Design Window Existing 3D Sample Design Window

Sample Design
3d Hotspat Ellipsoidal Shape

=l

X Radius Y Radius Z Radius

Maximun angle of rotation for z

Number of Simulations (e.g. >1000)

* Size ko 20

Store design as... I

The initial sample design proposed and
evaluated here is replaced by the actual
sample locations in the 3d Search
Efficiency Feature

For a quick demonstration, open the file ThreeDimensional.sda. This is a 3d data set that was
originally a 5 x 5 3d design with a 74% probability of discovering an elliptical 3d volume of
dimensions 150 x 150 x 3ft (see Chapter 39 for definition of 3d volume geometry).
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When the samples were collected, however, they could not adhere to this strict gridded pattern.
As you can see by the Chlordane measurements, adjustments were made, resulting in the

following map.

( ]

. ® ® B —" &

In this hypothetical example, two things are observed. First, this deviates from the strict
sampling grid. Secondly, suppose that a screening of the values yielded no points above the
decision criterion. The question becomes, could we have missed an elevated area with more
likelihood than 26% (100-74=26%)? To find out, select from the Statistics menu 3d Hotspot
Search efficiency. Enter the parameters as you see them below and Press OK.

*n. 3d Hotspot Search B|

3d Hotspat Ellipsoidal Shape

¥ Radius Y Radius 7 Radius
150 180 E

Maxirmurn angle of rotation for z. 4
MNumber of Simulations (e.g. =1000)  |soon

Results
Probability of a hit = 0.66. Average number
of hits = 11.6502.

aK Help | Cluit ‘

Here, we see in the Results summary that the probability of a hit (or probability of discovering an
elevated ellipsoidal volume) is now about 66% (your value may vary slightly due to the nature of
random realizations/simulations). This represents about an 8% (74-66=8%) reduction in
reliability due to the adjustments made at sample time. The average number of hits is around
11.6. This means that on average, when a 3d ellipsoid is simulated, a hit is “discovered” or “hit”
by about 11 existing samples each time. Press the Quit button to close the window.
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Summary

SADA provides a basic set of statistical features. If you need other statistics, you can export
your data out of SADA into a csv file, where it can then be imported into a statistics package.
Finally, many of these statistical features apply to both gridded and point data. It is important,
particularly in the case of some univariate statistics, to properly interpret gridded statistics. For
example, SADA will report a UCL95 for a modeled dataset. This value is meaningless, however,
as it depends on the number of values, which is arbitrarily set by the modeler. For an overview
of environmental statistics, we find the book by Richard Gilbert, Statistical Methods for
Environmental Pollution Monitoring, to be an excellent source.

References

Gilbert, R. 1987 Statistical Methods for Environmental Pollution Monitoring, Wiley & Sons, NY.
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Chapter 13: How to Perform a Quick Spatial Data Screen

One of the earliest decision tools you can apply to your data is a simple data screen. In this tool,
SADA uses a decision criterion to spatially identify those point values that exceed a screening
criterion. There are different ways to arrive at a screening value. You could simply provide one
just before the screen; screening values can be imported into SADA using the Custom Analysis
feature; screening values in the form of preliminary remediation goals, or PRGs, can be
calculated by SADA based on your calibration of the human health risk model; or screening
values in the form of ecological benchmarks can be used after you’ve setup the ecological risk
assessment. In this chapter, we will deal with the simplest scenario, where you will simply
provide the value to SADA as the screening tool is initiated. The other methods have chapters
dedicated to them later on in this user guide.

Open ThreeDimensional.sda (File *Open).

Regardless of how you arrive at a screening value, you will access the screening tool by
choosing the interview Draw a data screen map. Select this interview now.

Anytime your selected analysis is General, you will be prompted for a screening value each time
your run a screen. Make sure General is selected now.

ﬂ|0rmvu data screen map - |
ﬂ General - |Groundwater ~ | |Chlordane

1

The steps for this interview are very straightforward. The first three steps deal with querying the
data, setting up the site, and using GIS layers. These have been covered in previous chapters.
What we are interested in here is the step Set Decision Threshold Type. Click on this step now.

= Decision Threshold Criteria B]

Decision Threshald

* Single Decision Critetia

" Depth Yariable Criteria

When you selectthis option. SADA uses the
depth dependent remedial criteria specified
in the vertical layer design you hawve currently
selected. To see these value goto the setup
the site step and edit the layer design

This step, or option, is available only for the General Analysis. On the parameter window, you
can screen your Chlordane data set against a single value or against screening criteria that vary
as a function of depth.

Single Decision Criteria

Let’s choose Single Decision Criteria. Press the Show The Results button, and you will be
prompted to enter a single screening value for Chlordane.
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*w, User Defined Decision Criteria

User defined decision goal |U 2|

Cancel |

Enter a value of 0.2 and press OK. SADA informs you that you have 30 points exceeding this
screening value.

30 points in your selected area exceed the specified threshold,

Press OK. SADA draws a square box around each value that exceeds 0.2. Notice in the
following image only four samples have boxes around them. This is because other samples that
are exceeding .2 are obscured from view in this 2d layer view. Some of them may exist below
this layer, while multiple exceedances may occur at the same location in this layer. For this
reason, SADA always reports the total number of exceedances so you know there may be more
below or above what you currently see.

Screen: Chlordane

X &7 & ; L9 & II "
; 2} . Rl &
a

Northing

xman A ImEEM rFrar mEr T BIABAT 0m
Easting

Sometimes it’s difficult to see the boxes, particularly with a photograph located directly behind
them. This is easy to change. From the main menu, choose Graphics >Set Various

Colors 2Screening Box. You'll be presented with a color palette. Select bright red and press
OK. You should be able to see red squares now.

Depth Variable Criteria

In some situations, the screening criteria may vary with depth, becoming perhaps more relaxed
when further from the surface. This can be handled by choosing the Depth Variable Criteria
option. It is important to know that currently SADA assigns screening/decision criteria of this
nature directly to the layering designs. So, you’ll need to enter the screening criteria in the
vertical layering editor.

First select Depth Variable Criteria. Then click on Setup the site. Make sure you have the
vertical layer design My Five Layers selected.
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=et Vertical Layers

|hf13,r Five Layers ﬂ Add

Double click to edit Delete

0-10 {Active with no polygons) ~
10-20 (Active with no palygons) il

Interpolate and Place Mew Samples

7 At the top &+ |n the middle

Double click the listing of individual layers to open the layer design window.

Set Vertical Layers

IMy Five Layers LI Add I
Double click to edit Delete |

|D-1D {Active with no polygons) ~
10-20 (Active with no polygons) ™
Interpolate and Place New Samples

" At the top @ In the middle

In the layer design window, enter the depth variable screening criteria in the remedial threshold
column exactly as you see it in the following picture:

Current Layering Design
Fram To Falygon Active Remedial Threshold
+» |D |1D |N0ne ﬂh’es ﬂ|ﬂ.2
1o 20 |None v ||ves RACE
20 a0 |None v ||ves >4
B0 40 |None v ||ves ~|ps
a0 50 |None v ||ves ~ e

Press OK. Now press the Show The Results button, and SADA will allow you to look at and edit
your depth variable screening criteria one more time before the screen is performed.

139



Introduction to Spatial Analysis and Decision Assistance

. Review and Edit Your Depth Based Criteria

X

|ZIlin Zlax Decision Value

oK ‘ Cancal ‘

Press the OK button, and SADA reports now that 20 points exceed the screening criteria. This is
less than 30, because the screening criteria increased above 0.2 as you increase depth;
therefore, fewer samples in the subsurface exceeded the criteria assigned to their layer. Switch
between the different layers to see which points exceeded their layer specific criteria.

What about multiple contaminants?

Of course, if you have multiple contaminants with depth variable criteria, this can be a bit
cumbersome but certainly doable. In future versions of SADA, we will improve this feature to
work with multiple sets of depth variable criteria as well as with human health, custom analysis,
and so forth. In the mean time, suppose you had two contaminants with depth-dependent
criteria (Arsenic and Ac-225). You would first create a layer design for Arsenic and fill in the
depth variable criteria. Then, you could create a second layer design named Ac-225 layers
(perhaps based on Arsenic layers) and fill in the depth dependent criteria for Ac-225. This isn’t
too bad, except you have to remember to switch the vertical layers when you switch the
contaminants.

Using the Legend Manager as a Screening Tool

The legend manager is covered in greater detail in Chapter 43. Here, we’ll focus on how to use
the legend manager to color ranges of numbers with different colors. This is essentially like a
data screen tool itself.

Close any file you may have open without saving and open TwoDimensional.sda. From the
main menu, select Graphics 2Legend Manager. From the drop-down list of legends, select (new
interval) and name the legend “Ac-225 Colors.” Press OK, and select Ac-225 from the list of
legends. Modify the legend so that it looks like the image below. If you don’t know how to do
this, see the sections on the Legend Manager in Chapter 43.
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| 4225 Colors |

Transparency

e

[ Use even categories.
Ct of range colors
Less than minimum .

Mare than maximum .

Edit Intervals/Categories

; Mew
g Edit
Colar
Delete

Help ‘

Apply | Close

This is really a two-part screen. All values above 3 will be assigned a red color. All values
between 1 and 3 will be assigned blue. Purple is assigned for the lowest value. Press the Apply
button and you can easily see the exceedances in the graphics window.

Delete

Entering by hand is the simplest ground-floor method of screening your data against set criteria.
In the next chapter, we’ll look at importing screening criteria from outside SADA. You can now
close your Twodimensional.sda without saving it.
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Part IV: Risk
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Chapter 14: Importing Custom Screening and Remediation Criteria (Custom
Analysis)

In the last chapter, we saw how to enter screening criteria by hand for spatial data screens. This
can be monotonous if you do a lot of screening or have multiple contaminants. The best
approach is to just import the criteria in from outside SADA. This is a custom analysis and
requires only a brief setup on the user’s part. Once imported into SADA, these values can be
used not only to screen data but to determine areas of concern and support sample design.

Preparing Custom Values

The first thing you'll need to do is create a table of custom values using a spreadsheet editor or
perhaps an Access database. All SADA needs is a name column and one or more columns
containing screening values. Columns can be in any order, and missing values are allowed in
the screening columns. If you have a column of CAS numbers, this can speed up the import
process a little but isn’t necessary. The following is a simple table created in Excel and has
been included in your installation files as CustomCriteria.xls. If you wish you can open it now.

E1 Microsoft Excel - Book1

IEJ Ble Edit Wew Insert Format Tools Data Window Help Adobe PDF

QN EH RSN VE S LA S D@

Sig) o P ) T | | & i | ¥ Rty with Changes... End Rey
k=N

F2 - o

A B | c
1 |Name First Tier Screening Walue Second Tier Screening Value
_2 |Ac-225 31 35
3 |Arsenic 23
4 |Barium 14 29
_ 5 |Anthracen 4 11

All you’'ll need to do in Excel is to save this as a comma separated value file (.csv). To do this,
select, in Excel, File>Save As... and select Comma delimited (*.csv) from the Save as type at
the bottom of the window.

File name: CustomCriteria.csy hd
Save as fype!  |cSv (Comma delimited) (*.csv) |>

i nima delimite )

Microsoft Excel 4.0 Woarksheet {*.xls)
Microsoft Excel 3.0 Worksheet (*.xls)
Microsoft Excel 2.1 Worksheet (*.xls)
Microsoft Excel 4.0 Workbook {*.xhw)
WK (1-2-33 (* wke) v

Enter CustomCriteria.csv as the name and press Save. Since CustomCiriteria.csv is already
installed with SADA, you maybe warned about an overwrite. If so, choose No. Otherwise, SADA
will ask you some questions about losing features of the Workbook and so forth. Just press
through this until you can finally save it.

Now let’s look at the .csv file to make sure it is in good shape, using a simple text editor called
Notepad. Sometimes, Excel-generated custom analysis files have the same problems as Excel-
based data files, which are discussed in the Chapter 5, “Importing Sampled Data” (namely, the
arbitrary and unpredictable placement of extraneous commas in the file).
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Let’s start by opening Notepad. From the Windows Start button, select All

Programs ->Accessories 2Notepad. Depending on how your desktop is set up, your Notepad
may be located elsewhere. Once Notepad is open, choose File 2Open, navigate to where
SADA has been installed (likely C:\Program Files\SADA 5.0), and open CustomCriteria.csv. In
the open window of Notepad, you'll need to make sure Files of type is set to All Files.

File name: |CustDmCriteria.csv b ‘
Files of type: Al Files v

Encoding: |AN5| w ‘

Select CustomCriteria.csv and press Open. Your file may look slightly different than the
following image, which shows a common problem with .csv files and Excel. The last row for
Anthracene has extraneous commas added. You'll need to clean this up by hand.

E"- CustomCriteria.csv - Notepad

File Edit Format ‘View Help

Name,First Tier Screening value,Second Tier Screening value
AC-225,3.1,3.5

Arsenic,?3,

Barium,14,29

Anthracene, 4,11, ,,,

Simply delete any unnecessary commas and save the file again.

E"- CustomCriteria.csv - Notepad

File Edit Format Wiew Help

Mame,First Tier Screening value,Second Tier Screening walue
AC-225,3.1,3.5

Arsenic,23,

Barium, 14,29

Anthracene, 4,11

Then, close Notepad.

An example of what custom criteria looks like in a Microsoft Access database has been sent
with your SADA installation. The file CustomCriteria.mdb contains some additional example
criteria as well as a CASNUM field.
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Micrasoft Access
DR EAt Mew [reert Format Becords Tock Window Hep Adobe POF

ol iR,
ih2 - T (3 2P 0 0 0 881 RLIT ) v 4 o as Y
B ExampleCustomAnalysis : Table r;l
CasUMm Analvies Rogional Level Slate Leval Background
7439965 Manganese 1670 1020
| 7440666  Zinc 159 1530
7440303 Barium &0 a0
| | 1440473 Chramium 11 S 159
| |7440020 Mickel 36 35
Lead 342 396
Copper 8 7.7
Asgenic 121 57
2 PAHSs, Totalu 355 13.7
Ac-225 3 35
7440438 Cadrmum 0592 17
| 1128000 Fyrens 0.57 323
218019 Chrysens as 52
| |sus28 Benzolalpyrens 0.35 0,394
| |191242 Benzo{ghi Jperyiens 0.23 63
56503 Berz[ajanthracens 026 4.2
| |1833a5 Indenof1,2,3-cd]pyrens 0.078 0837
20440 Flusrariheane 0 0842 0834
| 186737 Fluorana 0.0346 0.652
| {91203 Naphthalene 0.0328 0.657
120127 Anlhracens 0.0316 0548
| 11336363 PCEs (total) 0.0316 0.245
205993 Barzo[b]fluararthens 00372
| | 207089 Barza[k|iuoranthens 00272
| |7440360  Antimony
_|53703 Dibenz[ahjarthracens 0.0282
» R Siver
T42997E Mercury
1429805 AlrminiEm SE000

| Recora: [EE| 7 |>|> of 2
Both of these files can be used as templates for establishing your own custom criteria files.
Close Excel and/or Access if you have them open. Let’s import CustomCriteria.mdb now.

Importing Custom Values

The import process is relatively trivial. Open SADA and open the file Twodimensional.sda. Save
the file as CustomExample.sda. To setup a custom analysis, from the main menu select
Setup 2Custom....

This initiates the custom setup processes.

Si. Custom Analysis Wizard

The custom analysis allows vou to import external infarmation into your SADA file.
The function of this anahysis is to allow you to compare your sampled values
against a set of guidelines that alternative to the human health or ecological risk

@ Import external values

@ Screen data against these values

@ Basis for developing decision maps, cost benefit
analysis, and secondary sampling designs.

[ el _ Hew» |

Press Next >>. The next window wants the name of the file containing your screening values.
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Si./Custom Analysis Setup

the infarmation you want to impaort.

Cancel | Next > |

Flease specify the comma delimited file ar Microsoft Access database that cg

Press the Browse button, change the Files of type to Microsoft Access (.mdb), and select

CustomCiriteria.mdb.

Open

ed 4
Lookin: |3 SADASD v ~@crEr
L. Ciecosupport
f E’ CRiskModels
My Recant - —
Documents
Desktop
%
My Documents
el /
File neme: [Cus!aanrenu mdk :] Open |
Files of type: [Micrasaft Access (mdb) ~| Cancel
My Metwork [~ Openas read-only \

N\

Press Open and Next>> on the last window. For Access files, you’ll need to choose the proper
table in your database. SADA shows you a snapshot of some of your records in each table. In
this example, we only have one table (ExampleCustomAnalysis). Select this and press OK.

=i Select a Recordset

Select atable fram CA\Program Files\SADA 5. 0\CustomCriteria mdb. When you choose a table, SADA will show you a preview of the table
content an the right

X

Cancel

Help |

casnum ‘Analyla ‘Rag\nna\ LE‘Slate Level |Ea:kgrnunt

205992 Benzo[blfluc 0.02

50328 Benzo[a]py 035 0.3394
53703 Dibenz[ahle 0.0282
56553 Benz[a]anth 0.26 42
86737 Fluarene 0.0348 0.652
91203 Naphthalen 0.0328 0.687
120127 Anthracene 0.0316 0.548
125000 Pyrene 057 3.23
191242 Benzolghile

193395 Indeno[1.2.2

The next thing SADA needs is to know which column in your table contains the contaminant
names and, if available, where the CASNUM column is found. Be very careful and make sure

you’ve matched up the columns exactly like the following image:
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Si. Custom Analysis Field Definitions B|

oADA now needs away to match wour contarminants with
contaminants inyour external data. To do this, you now
need specity which field contains the cantaminant names
and which field contains CAS numbers (if any).

Contaminant Mames

CAS Mumbers ||:a5num ﬂ

Ca